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In questa Guida…
Questa guida contiene informazioni sull'utilizzo dei dati Software Agilent 
MassHunter Workstation - Qualitative Analysis GC/MS. 

Prima di iniziare con le esercitazioni, leggere le istruzioni in “Prima di iniziare 
con le esercitazioni...” a pagina 5.

Esercitazione 1 Concetti base di analisi qualitativa

Questa esercitazione consente di esplorare molte delle importanti funzionalità 
del programma Qualitative Analysis. Queste attività sono essenziali, 
indipendentemente dal tipo di dati utilizzati.

Esercitazione 2 Ricerca e identificazione

Nelle prime due serie di operazioni, si trovano e identificano sulfonamidi a 
bassa concentrazione  all’interno di una complessa matrice e si genera la loro 
formula per i dati sia TOF che Q-TOF. Si esegue anche un’estrazione 
molecolare sulla digestione di una proteina con dati sia TOF che Q-TOF. 
Queste operazioni possono essere eseguite anche su dati a triplo quadruplo.

Esercitazione 3 Utilizzo di workflow, esportazione e stampa

In queste attività viene spiegato come impostare ed eseguire un metodo di 
analisi qualitativa. Viene anche spiegato come modificare un metodo per 
automatizzare l’analisi e/o l’identificazione del composto. All’apertura del file 
di dati, vengono eseguite le azioni all’interno del metodo automatico. Viene 
inoltre spiegato come creare un metodo per eseguire azioni automatizzate con 
una lista di lavoro. Tutte queste attività sono eseguite utilizzando un workflow 
diverso.

Riferimenti

Questo capitolo tratta i concetti base del programma Qualitative Analysis.
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Novità

in B.06.00

• È possibile rivedere i composti in Compound Details View. In Compound 
Details View sono state aggiunte altre quattro finestre.

• Per Compound Details View, è possibile definire linee diverse a seconda 
degl tipo di cromatogramma e spettro.

• È disponibile l'algoritmo Find Compounds by Integration.

• È possibile eseguire la ricerca in più librerie utilizzando l'algoritmo Search 
Unit Mass Library.

• Nell'algoritmo Generate Formulas, è possibile aggiungere delle formule ai 
picchi dello spettro con frammenti. L'annotazione del frammento avviene 
selezionando gli spettri da annotare sulla base dell'algoritmo di estrazione 
del composto.

• L'algoritmo Generate Formulas può essere eseguito su composti trovati 
mediante l'algoritmo Find by Chromatogram Deconvolution.

• L'algoritmo Generate Formula è stato modificato e consente ora di inserire 
un numero massimo di risultati per ciascun portatore di carica.

• Nell'algoritmo Generate Formulas, è possibile raggruppare risultati con la 
stessa formula e portatori di carica diversi.

• È possibile creare i composti da un qualsiasi spettro utente. L'algoritmo di 
estrazione del composto per questi composti è “Spectrum Extraction”.

• Durante il salvataggio dei dati e del file di dati, è possibile decidere se 
salvare tutti i risultati dei composti oppure una piccola parte per ciascun 
composto. Tutti i cromatogrammi e gli spettri utente vengono sempre 
salvati.

• Il formato del file CEF è stato modificato in modo da consentire 
l'inserimento di più informazioni.

• Le informazioni su m/z e specie di ioni sono disponibili nel primo livello 
della tabella Spectrum Identification Results.

• La tabella Spectrum Identification è stata modificata. È possibile 
aggiungere un filtro ad una colonna ed è possibile eliminare una riga.

• Con Formula & Ion Species ora è possibile etichettare un picco.

• Ora, modificare lo spettro identificato con Best nella finestra Spectrum 
Identification Results è un'operazione molto più veloce anche quando il 
numero di inserimenti è elevato.
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• È possibile specificare di sovrapporre i cromatogrammi dei composti in 
Compound Report.

• Il modello di rapporto predefinito Formula Confirmation è stato 
modificato e ora può includere la colonna colorata Flags (Tgt) e la tabella 
Fragment con la colonna colorata Flags (FIs).

Prima di iniziare con le esercitazioni...
• Installare il software. Consultare la Guida di installazione per le istruzioni.

• Copiare la cartella Data dal disco di installazione e decomprimerla sul disco 
rigido. 

In questa cartella sono contenuti tutti i file di dati necessari per 
le esercitazioni. Estrarre innanzitutto i file di dati dalla cartella in 
formato .zip.

NOTE Non riutilizzare i file di dati d'esempio che si trovano sul sistema a meno che siano stati 
copiati dagli originali su disco e non siano stati utilizzati da altri utenti. Se i file di dati 
d'esempio sul sistema non sono identici agli originali su disco, i risultati che si otterranno 
durante le esercitazioni non saranno paragonali a quelli illustrati in questa guida.
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Software Agilent MassHunter Workstation  Qualitative Analysis
Guida conoscitiva
1
Concetti base di analisi qualitativa

Attività 1. Aprire il programma Qualitative Analysis 10

Attività 2. Configurare l'interfaccia utente per i dati GC/MS 12

Attività 3. Ingrandire e ridurre il cromatogramma 15

Attività 4. Ancorare un cromatogramma 16

Attività 5. Modificare i layout delle finestre 17

Attività 6. Estrarre i cromatogrammi 19

Attività 7. Integrare un cromatogramma GC/MS in modo interattivo 21
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Attività 9. Estrarre gli spettri da un cromatogramma 29

Attività 10. Aggiungere annotazioni 39

Attività 11. Aggiungere un calibro della massa 43

Questa esercitazione consente di esplorare molte delle importanti funzionalità 
del programma Qualitative Analysis e utilizzare i dati GC/Q-TOF e GC/QQQ

Ciascuna esercitazione è riassunta in una tabella di tre colonne:

• Passi - Seguire tali istruzioni generali per procedere da soli e scoprire 
il programma.

• Istruzioni dettagliate - Seguire queste istruzioni in caso di dubbio o se 
si preferisce procedere gradatamente alla conoscenza del programma.

• Commenti – Consigli e informazioni aggiuntive su ciascun passo 
dell'esercitazione.
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1 Concetti base di analisi qualitativa
Attività 1. Aprire il programma Qualitative Analysis
Attività 1. Aprire il programma Qualitative Analysis

In questa attività, si utilizza il metodo corrente per aprire più file di dati. 

 

Attività 1. Apertura del programma Qualitative Analysis con più file di dati

Passi Istruzioni dettagliate Commenti

1 Aprire il programma Qualitative 
Analysis. 
• Aprire il file di dati Pest - 200 - 

Scan.d, Pest - STD 200 MRM.d, 
Pest Strawb-01 SPIKED 1 ppb - 
1 ul inj.d e 
MSD_mix_4stds_DG_spl200_0
3.d nella cartella 
\\MassHunter\Data, o nella 
cartella in cui sono stati copiati.

a Fare doppio clic sull'icona Agilent 
MassHunter Qualitative Analysis 
B.06.00 . 
Si apre la finestra di dialogo Open Data 
Files.

b Scorrere fino alla cartella \\
MassHunter\Data\GC o la cartella in 
cui si trovano i file di esempio.

• Il file Pest - 200 - Scan.d contiene 
dati MS, i file Pest - STD 200 MRM.d 
e Pest Strawb-01 SPIKED 1 ppb - 1 
ul inj.d contengono sia i dati MS che 
MS/MS (tutti i dati GC/QQQ). Il file 
MSD_mix_4stds_DG_spl200_03.d 
contiene i dati GC/Q-TOF.

• In caso di ulteriori informazioni sulla 
maggior parte delle finestre, delle 
finestre di dialogo e delle schede, 
premere il tasto F1 quando la 
finestra è attiva.

• Controllare che l'opzione Use 
current method sia selezionata.

• Controllare che la casella di 
controllo Load result data non 
sia contrassegnata. Se la casella 
Load result data non è 
disponibile, i risultati non sono 
stati salvati nel file di dati. Per 
informazioni sul salvataggio dei 
risultati, vedere “Attività 17. 
Salvare i risultati” a pagina 64.

• Verificare che la casella di 
controllo Run ‘File Open’ 
actions from selected method 
non sia selezionata.

Figura 1 Apertura dei file di dati all'avvio del software
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Concetti base di analisi qualitativa 1
Attività 1. Aprire il programma Qualitative Analysis
c Tenere premuto il tasto Shift e fare clic 
su Pest - 200 - Scan.d, Pest - STD 200 
MRM.d, Pest Strawb-01 SPIKED 1 
ppb - 1 ul inj.d e 
MSD_mix_4stds_DB_spl200_03.d.

d Fare clic su Open.
Nella finestra Data Navigator vengono 
visualizzati i quattro file di dati, mentre 
nella finestra Chromatogram Results 
compaiono da 1 a 3 cromatogrammi.

e Fare clic sull'icona List Mode  
nella barra degli strumenti 
Chromatogram Results.

• Premendo il tasto Ctrl, è possibile 
trascinare i file non attigui uno 
all'altro nell'elenco.

• Quel che viene visualizzato ora nella 
finestra varia a seconda delle 
impostazioni definite per metodo, 
layout, visualizzazione e tracciato 
prima dell'apertura di questi file.

• Selezionando l'icona List Mode, lo 
sfondo dell'icona diventa arancione.

Figura 2 Caricamento della finestra principale di Qualitative Analysis con workflow GC/Q-TOF Compound 
Screening

Attività 1. Apertura del programma Qualitative Analysis con più file di dati (segue)

Passi Istruzioni dettagliate Commenti

N. massimo 
dell'icona List Panes

Icona Display 
Options

Selezionare il pulsante X 
per chiudere la finestra.
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1 Concetti base di analisi qualitativa
Attività 2. Configurare l'interfaccia utente per i dati GC/MS
Attività 2. Configurare l'interfaccia utente per i dati GC/MS

In questa attività, è possibile selezionare il workflow General (per operatori 
GC/QQQ) o il workflow GC/Q-TOF Compound Screening (per operatori 
GC/Q-TOF). Questi workflow sono gli unici due che consentono di analizzare i 
dati GC/MS. Quindi, aprire la finestra di dialogo User Interface Configuration 
e selezionare la casella di controllo appropriata per un sistema GC/QQQ o un 
sistema GC/Q-TOF.

Attività 2. Configurare l'interfaccia utente per GC

Passi Istruzioni dettagliate Commenti

1 Se necessario, aprire il programma 
Qualitative Analysis. 

a Fare doppio clic sull'icona Agilent 
MassHunter Qualitative 
Analysis . 
Si apre la finestra di dialogo Open Data 
Files.

b Fare clic su Cancel nella finestra di 
dialogo Open Data Files.

• In caso di ulteriori informazioni su 
finestre, finestre di dialogo le 
schede, premere il tasto F1 quando 
la finestra è attiva.

2 Scegliere il workflow General o il 
workflow GC/Q-TOF Compound 
Screening.

a Se si possiede uno strumento 
GC/QQQ, fare clic sul comando 
Configuration > Configure for 
Workflow > General. Se si possiede 
uno strumento GC/Q-TOF, fare clic sul 
comando Configuration > Configure 
for Workflow > GC/Q-TOF Compound 
Screening.

b Fare clic sul pulsante Load workflow’s 
default method e il pulsante Load 
workflow’s default layout.

c Fare clic su OK.
d Fare clic sull'icona List Mode  

nella barra degli strumenti 
Chromatogram Results.

• Se il programma Data Acquisition 
per GC/QQQ o GC/Q-TOF è 
installato sullo stesso computer, il 
softwaare configura l'interfaccia 
utente automaticamente. 
È possibile che la sezione 
GC/Q-TOF Compound Screening sia 
già disponibile nella finestra 
Method Explorer.

• Per impostazione predefinita, i 
cromatogrammi vengono 
sovrapposti. Per questi esempi, i 
cromatogrammi vengono 
visualizzati in List Mode.
12 Software Agilent MassHunter Workstation - Guida conoscitiva di Qualitative Analysis per LC/MS



Concetti base di analisi qualitativa 1
Attività 2. Configurare l'interfaccia utente per i dati GC/MS
3 Se si dispone di un GC/QQQ, 
configurare l'interfaccia utente in 
modo da visualizzare solo le 
funzioni di GC/QQQ.

a Selezionare Configuration > User 
Interface Configuration.

b In Separation types, selezionare solo la 
casella di controllo GC.

c Se si dispone di uno strumento 
GC/QQQ, in Ionization type, 
contrassegnare anche la casella di 
controllo EI or other “hard” ionization 
technique e deselezionare la casella 
CI, APCI, ESI, MADLDI or other “soft” 
ionization technique.

d In Mass accuracy, deselezionare la 
casella di controllo Accurate mass 
(TOF, Q-TOF). Contrassegnare la casella 
di controllo Unit mass (Q, QQQ).

e In Optional software features, 
deselezionare la casella di controllo 
Peptide Sequence Editor e selezionare 
la casella BioConfirm Software.

f In Non-MS detectors, deselezionare le 
caselle UV e ADC.

g Contrassegnare la casella Show 
advanced parameters.

h Fare clic su OK.

• I comandi nella finestra di dialogo 
User Interface Configuration 
vengono modificati. 

• Se una funzione non è visibile, con 
ogni probabilità è stata nascosta nel 
momento in cui è stata 
deselezionata una casella di 
controllo nella finestra di dialogo 
User Interface Configuration.

Figura 3 Configurazione dell'interfaccia utente per utilizzare i dati GC/QQQ

Attività 2. Configurare l'interfaccia utente per GC

Passi Istruzioni dettagliate Commenti
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1 Concetti base di analisi qualitativa
Attività 2. Configurare l'interfaccia utente per i dati GC/MS
4 Se si dispone di un GC/Q-TOF, 
configurare l'interfaccia utente in 
modo da visualizzare solo le 
funzioni di GC/Q-TOF.

a Selezionare Configuration > User 
Interface Configuration.

b In Separation types, selezionare solo la 
casella di controllo GC.

c In Ionization type, selezionare le due 
caselle di controllo.

d In MS levels, selezionare le due 
caselle di controllo.

e In Mass accuracy, selezionare la casella 
di controllo Accurate mass (TOF, 
Q-TOF). Non selezionare la casella di 
controllo Unit mass (Q, QQQ).

f In Optional software features, 
deselezionare la casella di controllo 
Peptide Sequence Editor e selezionare 
la casella BioConfirm Software.

g In Non-MS detectors, deselezionare le 
caselle UV e ADC.

h Contrassegnare la casella Show 
advanced parameters.

i Fare clic su OK.

• I comandi nella finestra di dialogo 
User Interface Configuration 
vengono modificati. 

• Se una funzione non è visibile, con 
ogni probabilità è stata nascosta nel 
momento in cui è stata 
deselezionata una casella di 
controllo nella finestra di dialogo 
User Interface Configuration.

Figura 4 Configurazione dell'interfaccia utente per GC/Q-TOF

Attività 2. Configurare l'interfaccia utente per GC

Passi Istruzioni dettagliate Commenti
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Concetti base di analisi qualitativa 1
Attività 3. Ingrandire e ridurre il cromatogramma
Attività 3. Ingrandire e ridurre il cromatogramma

In questa attività si approfondiscono le funzioni di ingrandimento 
e di riduzione del programma Qualitative Analysis.
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1 Concetti base di analisi qualitativa
Attività 4. Ancorare un cromatogramma
Attività 4. Ancorare un cromatogramma

In questa attività viene ancorato un cromatogramma. Quando un 
cromatogramma viene ancorato, ?tale cromatogramma rimane costantemente 
sul display mentre si scorrono gli altri cromatogrammi da visualizzare.

Attività 4. Ancorare un cromatogramma

Passi Istruzioni dettagliate Commenti

• Ancorare un cromatogramma.
• Visualizzare tutti i 

cromatogrammi.
• Controllare che l'elenco di 

visualizzazione del 
cromatogramma sia impostato 
su 1.

• Nella finestra Chromatogram 
Results, selezionare il secondo 
TIC.

• Ancorare questo TIC.
• Scorrere l’elenco dei 

cromatogrammi.
• Eliminare l'ancoraggio.

a In Data Navigator, selezionare le 
caselle di controllo relative ai 
cromatogrammi nascosti nell'attività 
precedente.

b Controllare che il numero massimo di 
riquadri nella finestra Chromatogram 
Results sia impostato su 1.

c Nella finestra Chromatogram Results, 
selezionare il secondo TIC.

d Fare clic con il tasto destro del mouse 
all'interno del cromatogramma, quindi 
selezionare Set Anchor.

e Utilizzando la barra di scorrimento 
nella finestra Chromatogram Results, 
scorrere l'elenco dei cromatogrammi. 
Il secondo TIC rimane sempre 
visualizzato come primo 
cromatogramma. 

f Selezionare Chromatograms > Clear 
Anchor.

• Quando un cromatogramma viene 
ancorato, appare l'icona di 
un'ancora nella finestra Data 
Navigator, a fianco del nome del 
cromatogramma ancorato.

• Nonostante l'elenco di 
visualizzazione ne indichi 1, nella 
finestra Chromatogram Results 
vengono visualizzati comunque due 
cromatogrammi dopo averne 
ancorato uno. Questo perché viene 
visualizzato un cromatogramma 
oltre a quello ancorato.

• È inoltre possibile fare clic con il 
tasto destro del mouse sul 
cromatogramma e selezionare 
Clear Anchor dal menu di scelta 
rapida.

Figura 5 TIC ancorato nella finestra Chromatogram Results
16 Software Agilent MassHunter Workstation - Guida conoscitiva di Qualitative Analysis per LC/MS



Concetti base di analisi qualitativa 1
Attività 5. Modificare i layout delle finestre
Attività 5. Modificare i layout delle finestre

In questa attività, le finestre vengono spostate all'interno della vista principale 
e vengono creati altri layout.

Attività 5. Modificare il layout delle finestre

Passi Istruzioni dettagliate Commenti

1 Modificare il layout delle finestre:
• Modificare la dimensione della 

finestra.
• Salvare il layout di una finestra
• Sbloccare il layout.
• Modificare la finestra 

Chromatogram Results perché 
possa essere mobile.

• Spostare la finestra 
Chromatogram Results.

• Visualizzare gli strumenti per 
riposizionare le finestre.

• Per modificare la dimensione di una 
finestra, trascinare la linea divisoria tra 
le finestre.

• Per salvare il layout di una finestra, 
selezionare Configuration > Window 
Layouts > Save Layout.

• Per sbloccare un layout, selezionare 
Configuration > Window Layouts > 
Lock Layout. 

• Per rendere mobile una finestra, fare 
clic con il tasto destro del mouse sulla 
barra del titolo e selezionare Floating 
dal menu di scelta rapida.

• Per spostare una finestra, selezionare la 
barra del titolo della finestra e trascinare 
la finestra nella posizione desiderata. 

• Per visualizzare gli strumenti di 
riposizionamento, trascinare la finestra 
sopra una delle altre finestre. Dopo 
averle sovrapposte, il programma 
visualizza diversi strumenti di layout, 
come quelli nella Figura 6.

• Se il layout è sbloccato, non 
compare un segno di spunta a 
fianco del menu Lock Layout.

• Gli strumenti di riposizionamento 
possono essere utilizzato soltanto 
se il layout non è bloccato.

• Inoltre, è possibile rendere mobile 
una finestra facendo doppio clic 
sulla barra del titolo della finestra.

• Il software dispone di diversi layout 
predefiniti. Tuttavia è possibile 
caricarne degli altri.

• Il software offre vari workflow, 
ciascuno dei quali carica un layout 
diverso. Passando ad un workflow 
diverso, si modifica anche il layout.

Figura 6 Strumenti di riposizionamento delle finestre
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2 Riposizionare la finestra 
Chromatogram Results.
• Spostare la finestra in alto, a 

sinistra, a destra e in basso 
rispetto alle altre finestre.

• Spostare due finestre 
contemporaneamente in modo 
che siano una sopra all'altra e 
che siano disponibile dalle 
schede in basso. 

• Ripristinare il layout predefinito.

• Se si trascina il cursore su una delle 
icone più piccole, la finestra trascinata 
sarà posizionata sopra, a destra, sotto 
o a sinistra rispetto alle altre finestre. 

• Trascinare il cursore sull'icona più 
grande. La finestra può essere 
posizionata sopra, a destra, sotto o a 
sinistra rispetto all'altra finestra anche 
trascinando il cursore sugli angoli 
dell'icona più grande.

• Per tabulare insieme due finestre, 
trascinare il cursore sul centro 
dell'icona più grande. Verrà visualizzata 
una versione shadow delle due finestre 
tabulate. Non trascinare più il mouse. 
Le due finestre verranno tabulate 
insieme.

• Selezionare Configuration > Window 
Layouts > Restore Default Layout.

• Il cursore si deve trovare su una 
delle frecce di una casella affinché 
sia possibile risposizionare le 
finestre.

• Selezionando il comando Restore 
Default Layout viene ripristinato il 
layout utilizzato nel workflow 
General e nel workflow GC/Q-TOF 
Compound Screening. Se si sta 
utilizzando un altro tipo di workflow, 
caricare il layout di quel workflow.

Attività 5. Modificare il layout delle finestre (segue)

Passi Istruzioni dettagliate Commenti
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Attività 6. Estrarre i cromatogrammi

In questa attività, i cromatogrammi vengono estratti dal TIC originale 
e poi uniti. 

Attività 6. Estrarre i cromatogrammi

Passi Istruzioni dettagliate Commenti

1 Estrarre e unire i cromatogrammi 
degli ioni estratti (EIC) dalle due 
masse nel file dati Pest - 200 
Scan.d.
• I valori m/z sono 129.0 e 414.2.
• Non unire i picchi delle singole 

masse in un cromatogramma.

a Nella finestra Data Navigator, 
deselezionare le caselle di controllo dei 
file di dati eccetto per Pest - 200 Scan.d.

b Aprire la finestra di dialogo Extract 
Chromatograms utilizzando l'opzione 
sotto o una delle opzioni sulla destra: 
• Selezionare Chromatograms > 

Extract Chromatograms.
c In List of opened data files, 

selezionare Pest - 200 - Scan.d.
d Nella casella di riepilogo Type, 

selezionare EIC.
e Nel campo m/z value(s), digitare 
129.0, 414.2

f Se necessario, deselezionare la casella 
di controllo Merge multiple masses into 
one chromatogram per fondere gli EIC.

g Fare clic su OK.
h Impostare Maximum number of list 

panes su 3 nella barra degli strumenti 
Chromatogram Results.

• I cromatogrammi possono essere 
estratti anche in uno dei seguenti 
modi:
• Fare clic con il tasto destro del 

mouse all'interno del 
cromatogramma, quindi selezionare 
Extract Chromatograms.

• Da Data Navigator, evidenziare 
TIC Scan per sulfas_PosMS.d, 
quindi selezionare TIC Scan e 
fare clic su Extract 
Chromatograms.

• È possibile utilizzare un livello MS di 
Tutto o di MS.

• È inoltre possibile decidere che i 
cromatogrammi estratti siano 
automaticamente integrati dopo 
l'estrazione.

• Un cromatogramma può inoltre 
essere estratto da uno spettro di 
massa.

Figura 7 Finestra di dialogo Extract Chromatograms
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Figura 8 Unione dei cromatogrammi degli ioni estratti (EIC) a confronto 
con il TIC originale

Attività 6. Estrarre i cromatogrammi (segue)

Passi Istruzioni dettagliate Commenti
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Attività 7. Integrare un cromatogramma GC/MS in modo interattivo

In questa attività si spiegano i vari modi per integrare un cromatogramma, 
modificare i parametri di integrazione per variare i risultati e calcolare il 
segnale /rumore dei picchi integrati per i dati MS/MS.

Attività 7. Integrare un cromatogramma GC/MS in modo interattivo

Passi Istruzioni dettagliate Commenti

1 Integrare il cromatogramma TIC 
Scan per il file di dati Pest - 200 - 
Scan.d utilizzando una delle 
opzioni elencate a destra.

a Selezionare il file di dati Pest - 200 - 
Scan.D nella finestra Data Navigator.

b Evidenziare il cromatogramma TIC Scan 
e utilizzare uno dei seguenti comandi:
• Dalla barra dei menu, selezionare 

Chromatograms > Integrate 
Chromatogram.

• Fare clic con il tasto destro del 
mouse in un punto qualsiasi della 
finestra del cromatogramma, quindi 
selezionare Integrate 
Chromatogram.

• Nella finestra Data Navigator, 
selezionare Pest - 200 - Scan.D > 
User Chromatograms > TIC Scan, 
quindi selezionare con il tasto destro 
TIC SCAN e poi Integrate 
Chromatogram.

• Il programma ha in pratica integrato 
tutti i picchi del cromatogramma.

• Selezionare l'integrazione per 
utilizzare i dati MS, MS/MS e GC 
nella finestra Method Editor.

• In questo caso si tratta di un 
cromatogramma MS. Pertanto i 
valori impostati nella sezione 
Integrate (MS) di Method Editor 
vengono utilizzati per integrare 
questo cromatogramma.

2 Visualizzare solo due 
cromatogrammi per volta.

• Selezionare 2 nella casella Maximum 
number of list panes della barra degli 
strumenti Chromatogram Results.

Figura 9 Integrazione del cromatogramma TIC Scan con molti piccoli picchi

Integrazione di molti piccoli picchi.
Software Agilent MassHunter Workstation - Guida conoscitiva di Qualitative Analysis per LC/MS 21



1 Concetti base di analisi qualitativa
Attività 7. Integrare un cromatogramma GC/MS in modo interattivo
3 Modificare la soglia per integrare 
meno picchi.
• Modificare la soglia per rilevare 

solo i tre picchi maggiori.

a Dalla finestra Method Explorer, 
selezionare Chromatogram > 
Integrate (MS) per visualizzare la 
scheda Integrate (MS).

b Selezionare l'integratore Agile.
c Selezionare la scheda Peak Filters.
d In Maximum number of peaks, 

selezionare Limit (by height) to the 
largest, e digitare 3.

• Un triangolo blu compare se si 
modifica un'impostazione rispetto 
al valore salvato nel metodo 
corrente. Il triangolo scompare, 
quando si salva il metodo.

Figura 10 Scheda Peak Filters con casella Limit (by height) to the 
largest selezionata

4 Reintegrare il cromatogramma e Fare clic sul pulsante  nella barra 
degli strumenti Method Editor per 
integrare il cromatogramma 
utilizzando la nuova impostazione.

• Notare che ora vengono integrati 
solo i tre picchi maggiori.

• Il picco a 2.491 minuti ha un'altezza 
maggiore rispetto al picco a 
16.858 minuti. Pertanto viene 
indicato come terzo picco.

Attività 7. Integrare un cromatogramma GC/MS in modo interattivo (segue)

Passi Istruzioni dettagliate Commenti
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Figura 11 Integrazione del cromatogramma TIC Scan dopo aver limitato il numero di picchi

5 Integrare il cromatogramma TIC 
MRM per il file di dati Pest - STD 
200 MRM.D.

a Nella finestra Data Navigator, 
selezionare TIC MRM per il file di dati 
Pest - STD 200 MRM.d. 

b Utilizzare uno dei seguenti comandi 
per integrare i cromatogrammi.
• Dalla barra dei menu, selezionare 

Chromatograms > Integrate 
Chromatogram.

• Fare clic con il tasto destro del 
mouse in un punto qualsiasi della 
finestra del cromatogramma, quindi 
selezionare Integrate 
Chromatogram.

• Nella finestra Data Navigator, 
selezionare con il tasto destro il 
cromatogramma evidenziato e fare 
clic su Integrate Chromatogram.

c Passare da 5,8 a 8,5 minuti.
d Impostare Maximum number of list 

panes su 2.

• Premere il tasto Ctrl per evidenziare 
più di un cromatogramma nella 
finestra Data Navigator.

• Il programma ha in pratica integrato 
tutti i picchi del cromatogramma.

• In questo caso si tratta 
cromatogrammi MS/MS. Pertanto i 
valori impostati nella sezione 
Integrate (MS/MS) di Method 
Editor vengono utilizzati per 
integrare questo cromatogramma. 
È possibile selezionare un 
integratore per integrare i 
cromatogrammi MS e utilizzarne 
un altro per integrare i 
cromatogrammi MS/MS.

Attività 7. Integrare un cromatogramma GC/MS in modo interattivo (segue)

Passi Istruzioni dettagliate Commenti
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Figura 12 Integrazione di cromatogrammi MRM 

6 Selezionare l'integratore MS/MS 
(GC). Modificare il filtro in modo 
che siano accettati solo i picchi 
con altezza assoluta maggiore o 
uguale a 20.000.

a Nella finestra Method Explorer, 
selezionare Chromatogram > 
Integrate (MS/MS).

b Selezionare MS/MS (GC) come 
Integrator.

c Selezionare la scheda Peak Filters.
d In Filter on, selezionare Peak height.
e In Height filters, contrassegnare la 

casella di controllo Absolute height.
f Digitare 60000 come Absolute 

height.

• Un triangolo blu compare se si 
modifica un'impostazione rispetto 
al valore salvato nel metodo 
corrente. Il triangolo scompare, 
quando si salva il metodo.

Figura 13 Scheda Peak Filters con casella Absolute height 
contrassegnata

Attività 7. Integrare un cromatogramma GC/MS in modo interattivo (segue)

Passi Istruzioni dettagliate Commenti
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7 Reintegrare il cromatogramma g Fare clic sul pulsante  nella barra 
degli strumenti Method Editor.

• Notare che ora vengono integrati 
solo i picchi maggiori.

Figura 14 Integrazione dei cromatogrammi TIC e EIC MS/MS con impostazione di una soglia più alta

8 Ripristinare i valori salvati per il 
metodo corrente e chiudere 
Method Editor.

a Selezionare la sezione Chromatogram 
> Integrate (MS/MS) in Method 
Explorer.

b Selezionare l'icona  in Method 
Editor.

c Selezionare la sezione Chromatogram 
> Integrate (MS) in Method Explorer.

d Selezionare l'icona . in Method 
Editor.

e Chiudere la finestra Method Editor.

• Per annullare le modifiche e 
ripristinare i valori del metodo 
caricato, fare clic sull'icona Restore 
to last saved values from file 

nella barra degli strumenti 
Method Editor. 

9 Eliminare tutti i cromatogrammi 
eccetto quello originale. Eliminare i 
risultati dell'integrazione dal 
cromatogramma originale.

a In User Chromatograms nella finestra 
Data Navigator, evidenziare tutti i 
cromatogrammi eccetto l'originale.

b Selezionare con il tasto destro i 
cromatogrammi evidenziati, quindi 
selezionare Delete.

c Selezionare tutti i cromatogrammi TIC.
d Selezionare Chromatograms > Clear 

Results.

• Usando il comando Clear Results, i 
cromatogrammi non vengono 
eliminati. Vengono rimossi i risultati 
relativi ai cromatogrammi. In questo 
caso vengono cancellati i valori 
dell'integrazione.

Attività 7. Integrare un cromatogramma GC/MS in modo interattivo (segue)

Passi Istruzioni dettagliate Commenti

Il picco più basso di 5,8 minuti non è più 
compreso tra i risultati dell'integrazione 
poiché l'altezza assoluta per questo picco è 
inferiore a 60.000 conteggi.
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Attività 8. Calcolare i valori di idoneità del sistema

In questa attività si spiegano i vari modi per integrare in modo interattivo un 
cromatogramma, modificare i parametri di integrazione per variare i risultati 
e visualizzare il segnale/rumore per ciascun picco. Sono inoltre disponibili 
informazioni sull'attivazione dei calcoli di idoneità del sistema.

Attività 8. Integrare un cromatogramma (MS) in modo interattivo

Passi Istruzioni dettagliate Commenti

1 Integrare il cromatogramma 
MSD_mix_4stds_DB_spl200_03.d 
e Pest - 200 - Scan.d utilizzando 
una delle opzioni elencate a destra.

a Contrassegnare la casella di controllo 
a fianco dei file di dati 
MSD_mix_4stds_DB_spl200_03.d 
nella finestra Data Navigator.

b Contrassegnare la casella di controllo 
a fianco dei file di dati Pest - 200 - 
Scan.d nella finestra Data Navigator.

c Evidenziare i due TIC.
d Integrare il cromatogramma TIC Scan 

per questi due file utilizzando una delle 
seguenti opzioni.
• Dal menu principale, selezionare 

Chromatograms > Integrate 
Chromatogram.

• Evidenziare il cromatogramma. 
Quindi, selezionare con il tasto 
destro il cromatogramma, e 
selezionare Integrate 
Chromatogram.

• In Data Navigator, evidenziare TIC 
Scan per i due file di dati. Quindi, 
selezionare con il tasto destro il 
cromatogramma, e selezionare 
Integrate Chromatogram.

• Per il workflow General, 
l'integrazione utilizza l'integratore 
General perché è il tipo selezionato 
nel metodo default.m. Per il 
workflow GC/Q-TOF Compound 
Screening, l'integrazione utilizza 
l'integratore Agile. 

• È possibile modificare questo valore 
nella scheda Chromatogram > 
Integrate (MS) > Integrator.

• Ricordare che l'integrazione rileva 
picchi molti picchi mantenendo i 
parametri predefiniti.
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Figura 15 Uno dei menu di scelta rapida in Data Navigator e i cromatogrammi integrati

2 Attivare i calcoli di idoneità del 
sistema per i cromatogrammi MS.

a Dal Method Explorer, selezionare 
Chromatogram > Integrate (MS) per 
visualizzare la scheda Integrator.

b Selezionare la scheda Suitability.
c Contrassegnare Enable system 

suitability calculations.
d Selezionare United States 

Pharmacopoeia (USP).
e Nella casella Column void time, 

digitare 1.
f Nella casella Column lengt, digitare 

3000.

• Un triangolo blu compare se si 
modifica un'impostazione rispetto 
al valore salvato nel metodo 
corrente. Il triangolo scompare, 
quando si salva il metodo.

• Gli algoritmi utilizzati per impostare 
alcune delle colonne in Peak List 
variano a seconda del tipo di 
farmacopea selezionato. Consultare 
la Guida in linea per ulteriori 
informazioni.

Figura 16 Scheda Chromatogram > Integrate (MS) Suitability

Attività 8. Integrare un cromatogramma (MS) in modo interattivo (segue)

Passi Istruzioni dettagliate Commenti

Il tempo di validità e la 
lunghezza effettivi della 
colonna per questi file di dati 
sono diversi rispetto a questi 
valori. Questi sono valori di 
esempio.
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3 Reintegrare il cromatogramma. • Fare clic sull'icona Integrate 
Chromatogram  nella barra degli 
strumenti Method Editor per integrare 
il cromatogramma utilizzando la nuova 
impostazione.

4 Visualizzare i calcoli di idoneità del 
sistema.
• Aprire la finestra Integration 

Peak List.
• Rivedere i valori della finestra del 

rumore e calcolare il rapporto 
segnale/rumore per i picchi 
integrati.

a Selezionare View > Integration Peak 
List.

b Selezionare con il tasto destro 
l'intestazione della finestra Peaks e 
fare clic su Floating.

c Fare clic con il destro sull'intestazione 
di una delle colonne da visualizzare e 
selezionare Remove Column. 

d Fare clic con il destro sull'intestazione 
di colonna e selezionare Add/Remove 
Columns per modificare le colonne 
visibili.

• I calcoli di idoneità del sistema 
vengono inclusi nella tabella 
Integration Peak List.

• I valori includo k’, fattore di coda, 
piastre, piastre/M e simmetria.

• È inoltre possibile attivare i calcoli 
di idoneità del sistema per un 
cromatogramma MS, MS/MS e GC.

Figura 17 Tabella Integrated Peaks con i valori di idoneità del sistema

5 Ripristinare le impostazioni del 
metodo predefinito, quindi 
chiudere la finestra Method Editor 
e Integration Peak List.

a Per annullare le modifiche e 
ripristinare i valori del metodo 
predefinito, fare clic sull'icona Restore 
to last saved values from file 

nella barra degli strumenti 
Method Editor. 

b Chiudere la finestra Method Editor.
c Selezionare con il tasto destro il titolo 

della finestra Peak List e fare clic su 
Floating.

d Selezionare View > Integration Peak 
List.

• Dopo aver selezionato il comando 
Floating dal menu di scelta rapida 
una seconda volta, la finestra 
Integration Peak List viene ancorata 
nella sua posizione iniziale.

Attività 8. Integrare un cromatogramma (MS) in modo interattivo (segue)

Passi Istruzioni dettagliate Commenti
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Attività 9. Estrarre gli spettri da un cromatogramma

In questa attività viene estratto uno spettro da un punto specifico del 
cromatogramma. Il programma Qualitative Analysis estrae uno spettro da 
un punto dati specifico o estrae uno spettro medio da un media di più punti 
dati o intervalli. 

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti

1 Scorrere un cromatogramma per 
visualizzare lo ione precursore e lo 
ione prodotto degli ultimi picchi di 
Pest - STD 200 MRM.d.
• Ingrandire la regione tra 13 e 16 

minuti.
• Utilizzare l'icona Walk 

Chromatogram.
• Rivedere gli spettri partendo da 

ca. 13 minuti e spostare la 
freccia verso destra. 

a Selezionare il file di dati Pest - 200 - 
MRM.D nella finestra Data Navigator.

b Chiudere la finestra Method Editor.
c Chiudere la finestra MS Spectrum 

Results.
d Selezionare il cromatogramma TIC 

MRM nella finestra Data Navigator.
e Fare clic sull'icona Autoscale Y-axis 

during Zoom  nella barra degli 
strumenti Chromatogram Results.

f Selezionare 1 come numero massimo 
di riquadri elenco.

g Per ingrandire alcuni picchi, fare clic 
con il tasto destro del mouse sopra il 
picco a 13 minuti e trascinarlo a 16, 
quindi rilasciare. 

h Fare clic sull'icona Walk 
Chromatogram  nella barra degli 
strumenti Chromatogram Results.

i Spostare il cursore Walk 
Chromatogram sopra l'asse delle X a 
13 minuti, e fare clic. 

j Per passare da spettro a spettro, 
utilizzare i tasti freccia SINISTRA e 
freccia DESTRA sulla tastiera.

• Lo strumento Walk Chromatogram è 
particolarmente utile con i dati 
MS/MS per identificare gli ioni 
precursore e prodotto.

• Lo spettro selezionato in ciascun 
punto della finestra Chromatogram 
Results viene automaticamente 
visualizzato nella finestra Spectrum 
Preview, che si apre da sé.

• Talvolta vengono visualizzati nella 
finestra Spectrum Preview due 
spettri. Ad esempio, nella finestra 
Spectrum Preview vengono 
visualizzati due spettri per ciascun 
punto selezionato vicino al picco a 
13,431 minuti.
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Figura 18 Utilizzo di Walk chromatogram per visualizzare due spettri MRM per il picco a 13,43 minuti

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti
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2 Estrarre gli spettri su punti dati 
specifici per il picco a 5,2 minuti e il 
picco a 14,3 minuti del file di dati 
Pest - STD 200 MRM.d.
• Estrarre uno spettro dal picco a o 

in prossimità di 5,2 minuti e uno 
a valle, utilizzando una delle 
opzioni descritte in Commenti.

• Estrarre uno spettro dal picco a o 
in prossimità di 14,3 minuti (non 
ancora a valle).

• Modificare la visualizzazione per 
rappresentare gli ultimi tre 
spettri.

a Fare clic sull'icona Range Select  
nella barra degli strumenti 
Chromatogram Results.

b Chiudere la finestra Spectrum Preview.
c Fare clic sull'icona Zoom Out  nella 

barra degli strumenti Chromatogram 
Results.

d Per ingrandire il picco a 5,2 minuti, fare 
clic con il tasto destro del mouse sopra 
il picco a 4,0 minuti e trascinarlo fino a 
6,0 minuti, quindi rilasciare. 

e Su un picco in prossimità di 5,2 minuti, 
estrarre uno spettro in uno dei modi 
elencati nella colonna Commenti.

f A valle in prossimità di 5,1 minuti, 
estrarre lo spettro.

g Fare clic sull'icona Zoom Out  nella 
barra degli strumenti Chromatogram 
Results.

h Ingrandire la regione tra 14 e 15 minuti. 
i Su un picco in prossimità di 

14,3 minuti, estrarre uno spettro in uno 
dei modi elencati nella colonna 
Commenti (non estrarre ancora lo 
spettro a valle).

j Se necessario, selezionare 4 in 
Maximum number of list panes nella 
barra degli strumenti MS Spectrum 
Results.

• Durante lo zoom, assicurarsi che 
l'opzione AutoScale Y-axis sia 
"attiva". Se è attiva, lo sfondo 
dell'icona diventa arancione.

• I cromatogrammi possono essere 
estratti in uno dei seguenti modi:
• Fare doppio clic sul punto dati del 

cromatogramma. 
• Fare doppio clic sul punto dati del 

cromatogramma, quindi fare clic 
con il tasto destro in un punto 
qualsiasi del cromatogramma. 
Selezionare Extract MS 
Spectrum. Verrà visualizzata la 
finestra di dialogo Extract 
Spectrum. Verificare che sia 
selezionato il file Pest - STD 200 
MRM.d, quindi fare clic su 
Extract nella finestra di dialogo 
Extract Spectrum.

• Nota: quando si estrae uno spettro, 
nella finestra MS Spectrum Results 
viene visualizzato lo spettro. Il tipo 
dello spettro e il tempo di ritenzione 
compaiono alla voce User Spectra. 
Tutti gli spettri estratti 
successivamente vengono 
visualizzati negli stessi punti.

• Quando si estrae uno spettro MS 
dal picco in prossimità di 
14,3 minuti, vengono estratti due 
spettri, poiché su quel picco hanno 
luogo due transizioni.

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti
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Attività 9. Estrarre gli spettri da un cromatogramma
Figura 19 Finestra principale con i due spettri MRM dal picco a 5,2 minuti e i due spettri MRM dal picco a 
14,3 minuti

3 Estrarre uno spettro MS dalla valle 
a 14,35 minuti del file di dati Pest - 
STD 200 MRM.d. 
• Attivare Spectrum Preview.
• Estrarre uno spettro dalla valle a 

14,3 minuti di RT.
• Copiare questo spettro nella 

cartella User Spectra.
• Modificare la visualizzazione per 

rappresentare 6 spettri.
• Disattivare Spectrum Preview.

a Selezionare l'icona Spectrum 
Preview .

b A valle in prossimità di 14,3 minuti, 
estrarre uno spettro.

c Selezionare con il tasto destro del 
mouse lo spettro nella finestra 
Spectrum Preview, quindi fare clic su 
Copy to User Spectra. Gli spettri 
vengono copiati nella sezione User 
Spectra in Data Navigator e visualizzati 
nella finestra MS Spectrum Results.

d Selezionare la freccia in giù vicino al 
riquadro degli spettri, e selezionare 6.

e Chiudere la finestra Spectrum Preview.

• Se la finestra Spectrum Preview è 
attiva, il sistema visualizza tutti gli 
spettri selezionati manualmente 
nella finestra Spectrum Preview e 
non nella sezione User Spectra di 
Data Navigator.

• Con Spectrum Preview attivata, il 
programma Qualitative Analysis 
sovrascrive lo spettro precedente 
dopo aver estratto quello nuovo.

• La modalità Spectrum Preview è 
utile per rivedere velocemente gli 
spettri nel cromatogramma e 
salvarne solo alcuni.

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti
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Attività 9. Estrarre gli spettri da un cromatogramma
Figura 20 Finester Chromatogram Results e MS Spectrum Results

4 Estrarre uno spettro medio di tutti i 
punti entro un intervallo specifico 
per il picco a 14,3 minuti per il file 
di dati Pest - STD 200 MRM.d :
• Ridurre.
• Utilizzare l'icona Range Select 

nella barra degli strumenti 
Chromatogram.

• Impostare l'intervallo sull'intero 
picco. 

• Estrarre lo spettro, utilizzando 
una delle opzioni elencate.

a Fare clic sull'icona Range Select  
sulla barra degli strumenti 
Chromatogram Results.

b Fare clic sul lato sinistro della base del 
picco a 14,3 minuti e trascinare la base 
del picco verso destra. 

c Estrarre lo spettro medio utilizzando 
una delle opzioni a destra.

d Selezionare 2 in Maximum number of 
list panes nella finestra MS Spectrum 
Results.

• È possibile estrarre uno spettro 
medio facendo doppio clic 
sull'intervallo selezionato nel 
cromatogramma. 

• Oppure, fare clic con il tasto destro 
su un punto qualsiasi del 
cromatogramma, quindi selezionare 
Extract MS Spectrum dal menu di 
scelta rapida.

• Nota: vengono visualizzati due 
spettri MRM medi.

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti
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Attività 9. Estrarre gli spettri da un cromatogramma
Figura 21 Finestre Chromatogram Results e MS Spectrum Results con due spettri medi

5 Estrarre gli spettri con media degli 
intervalli dei picchi a 5,2 minuti e 
14,3 minut per il file di dati Pest - 
STD 200 MRM.d.
• Suggerimento: utilizzare l'icona 

Range Select e il tasto Ctrl per 
selezionare l'intervallo del Picco 
1 rilevato dal punto a metà.

• Estrarre lo spettro utilizzando 
una delle opzioni a destra.

a Fare clic sull'icona Zoom Out nella 
barra degli strumenti Chromatogram 
Results.

b Premere il tasto Ctrl.
c Fare clic sul lato sinistro della base del 

picco a 5,2 minuti e trascinare verso la 
destra del picco, quindi rilasciare il 
mouse.

d Rilasciare il tasto Ctrl.
e Estrarre gli spettri medi utilizzando 

questa opzione o una a destra:
• Fare doppio clic all'interno 

dell'intervallo selezionato in uno dei 
due picchi.

• Ricordare che per il secondo picco è 
già stato selezionato un intervallo 
nel Passo 4.

• Per estrarre uno spettro, è possibile 
anche fare clic con il tasto destro in 
un punto qualsiasi del 
cromatogramma e selezionare 
Extract MS Spectrum. Si apre la 
finestra di dialogo Extract 
Spectrum. Selezionare Extract.

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti
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Attività 9. Estrarre gli spettri da un cromatogramma
Figura 22 Due spettri medi da due diversi intervalli nel cromatogramma

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti

Il primo spettro presenta transizioni 
dai due intervalli temporali. Il 
secondo spettro ha solo un intervallo 
temporale poiché la transizione 
160.00 -> ** non esiste nel picco a 
5,2 minuti.
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6 Sottrarre uno spettro di fondo ogni 
qual volta si estrae uno spettro del 
picco di Pest - STD 200 MRM.d.
• Eliminare tutte le scansioni alla 

voce User Spectra in Data 
Navigator.

• Estrarre uno spettro di fondo che 
sia la media di uno spettro 
all'inizio del picco e uno spettro 
alla fine del picco.

• Estrarre uno spettro del picco dai 
picchi integrati.

a Fare clic sulla riga User Spectra in Data 
Navigator. Fare clic con il tasto destro 
sulla riga User Spectra, e selezionare 
Delete.

b Fare clic su Yes.
c In Method Explorer, selezionare 

Spectrum > Extract (MS/MS). 
d Fare clic sulla scheda Peak Spectrum 

Extraction (MS/MS), se non è visibile.
e Nella finestra Peak spectrum 

background MS/MS, selezionare 
Average of spectra at peak start and 
end.

f Nella barra degli strumenti 
Chromatogram Results, selezionare 
l'icona Peak Select .

g Selezionare il comando 
Chromatograms > Integrate.

h Selezionare il picco a 5,206 minuti.
i Fare clic con il tasto destro e 

selezionare Extract Peak Spectrum 
dal menu di scelta rapida.

• Alla fine del processo, a tutti gli 
spettri del picco estratti viene 
automaticamente sottratto il 
rispettivo spettro di fondo.

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti
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Attività 9. Estrarre gli spettri da un cromatogramma
Figura 23 Spettri del picco con spettro di fondo sottratto

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti
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7 Integrare ed estrarre gli spettri del 
picco dal file di dati Pest - STD 200 
MRM.d.

a Selezionare il cromatogramma TIC 
MRM nella finestra Data Navigator.

b Selezionare Chromatograms > 
Integrate e Extract Peak Spectra.

• Gli spettri del picco estratti 
manualmente nel passo precedente 
vengono eliminati 
automaticamente. Per impostazione 
predefinita, difatti, la casella di 
controllo Clear previous peak 
spectra è selezionata nella scheda 
Chromatograms > Integrate 
(MS/MS) > Results.

Figura 24 Integrazione ed estrazione degli spettri del picco

8 Rimuovere i risultati 
dell'integrazione e gli spettri del 
picco.

a Selezionare il file di dati Pest - Std 200 
MRM.d.

b Selezionare Chromatograms > Clear 
Results> Include Peak Spectra.

• Oppure selezionare 
Chromatograms > Clear Results > 
Only Chromatograms se non si 
intende eliminare gli spettri del 
picco.

Attività 9. Estrarre gli spettri da un cromatogramma

Passi Istruzioni dettagliate Commenti
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Attività 10. Aggiungere annotazioni
Attività 10. Aggiungere annotazioni

Alle seguenti finestre grafiche è possibile aggiungere un'immagine o un testo:

• Finestra Chromatogram Results

• Finestra MS Spectrum Results 

Le annotazioni vengono salvate insieme ai risultati del file di dati.

Attività 10. Aggiungere annotazioni

Passi Istruzioni dettagliate Commenti

1 Selezionare il file di dati 
MSD_mix_4stds_DG_spl200_03.d. 
Nascondere gli altri 
cromatogrammi.

a Contrassegnare la casella di controllo 
a fianco di 
MSD_mix_4stds_DG_spl200_03.D 
nella finestra Data Navigator.

b Selezionare Edit > Show > Only 
Highlighted.

• I cromatogrammi degli altri file di 
dati vengono automaticamente 
nascosti.

2 Scegliere il punto in cui aggiungere 
un testo all'interno del 
cromatogramma.

a Nella finestra Chromatogram Results, 
selezionare lo strumento Annotation 
( ) nella barra degli strumenti.

b Spostare il cursore nel punto del 
riquadro del cromatogramma in cui si 
vuole aggiungere l'annotazione.

c Con il tasto destro del mouse 
selezionare Add Text Annotation.

• Il cursore si trasforma in un mirino. 
Utilizzare il cursore per selezionare 
il punto esatto in cui aggiungere 
l'annotazione.

• Nella finestra Chromatogram 
Results, è disponibile la barra degli 
strumenti Annnotate.

• È possibile aggiungere delle 
annotazioni anche alla finestra MS 
Spectrum Results.

3 Aggiungere il testo 
dell'annotazione della finestra di 
dialogo Add/Edit Text Annotation

a Digitare Text per l'annotazione.
b Selezionare Text color.
c Selezionare Orientation.
d Selezionare Font style e Font size.
e Fare clic su Anchored o Floating. Se si 

sceglie Anchored, selezionare le opzioni 
del puntatore del testo. Se si seleziona 
Floating, è possibile modificare la 
posizione. È più semplice modificare la 
posizione in modo interattivo all'interno 
della finestra grafica.

f Fare clic su OK.

• È possibile aggiungere ad un 
cromatogramma o uno spettro più 
di un'annotazione.

• Utilizzare le icone nella barra degli 
strumenti Annotate per selezionare 
tutte le annotazione, eliminarle o 
modificarle.
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Attività 10. Aggiungere annotazioni
Figura 25 Finestra di dialogo Add/Edit Text Annotation e finestra Chromatogram Results

4 Scegliere il punto in cui aggiungere 
un'immagine all'interno del 
cromatogramma.

a Spostare il cursore nel punto del 
riquadro del cromatogramma in cui si 
vuole aggiungere l'annotazione.

b Con il tasto destro del mouse 
selezionare Add Image Annotation.

• È possibile aggiungere un file 
immagine nel formato JPG o MOL.

Attività 10. Aggiungere annotazioni (segue)

Passi Istruzioni dettagliate Commenti

La barra degli strumenti Annotate è disponibile solo se è si 
seleziona lo strumento Annotate.
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5 Aggiungere il testo 
dell'annotazione della finestra di 
dialogo Add/Edit Text Annotation

a Digitare Text per l'annotazione.
b Nel campo Scale width digitare 50.
c Contrassegnare la casella Lock aspect 

ratio.
d Fare clic su Floating. La posizione 

dell'immagine può essere modificata. 
È più semplice modificare la posizione 
in modo interattivo all'interno della 
finestra grafica.

e Fare clic su OK.
f Spostare l'immagine più in alto, 

nell'angolo destro del 
cromatogramma.

• Il file Agilent_Logo.tif si trova nella 
cartella \\MassHunter\Report 
Templates\Qual\B.05.00\en-US\
Letter. È necessario per convertire 
in un file JPG.

• È possibile aggiungere ad un 
cromatogramma o uno spettro più 
di un'annotazione.

Figura 26 Finestra di dialogo Add/Edit Image Annotation e finestra Chromatogram Results

6 Ingrandire il primo picco. • Ingrandire l'area che circonda il primo 
picco a 5,5 minuti.

Attività 10. Aggiungere annotazioni (segue)

Passi Istruzioni dettagliate Commenti
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Figura 27 Finestra di dialogo Add/Edit Image Annotation e finestra Chromatogram Results

7 Tornare allo strumento Range 
Select nella finestra 
Chromatogram Results. 
Innanzitutto eliminare 
l'annotazione.

a Fare clic sull'icona  per rimuovere 
tutte le annotazioni.

b Fare clic sull'icona (Range 
Select) nella barra degli strumenti 
Chromatogram Results.

• Per salvare le annotazioni insieme 
ai risultati dei file di dati, vedere 
“Attività 17. Salvare i risultati” 
a pagina 64.

• È possibile scegliere tra cinque 
diversi strumenti nella barra degli 
strumenti Chromatogram Results. 
Consultare la Guida in linea per 
ulteriori informazioni. I cinque 
strumenti disponibili sono:
• Range Select
• Peak Select
• Manual Integration
• Walk Chromatogram
• Annotation Mouse

Attività 10. Aggiungere annotazioni (segue)

Passi Istruzioni dettagliate Commenti

Se un'annotazione è ancorata, rimane nella 
posizione in cui è stata ancorata. Se si 
ingrandisce un altro picco, l'annotazione 
ancorata potrebbe non essere visibile. 
Se un'annotazione è mobile, viene sempre 
visualizzata nella stessa posizione, 
nell'angolo in alto a sinistra della finestra.
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Attività 11. Aggiungere un calibro della massa

Un calibro misura la differenza tra due punti in uno spettro. È possibile 
aggiungere un calibro alla finestra MS Spectrum Results.

I calibri vengono salvati insieme ai risultati del file di dati.

Attività 11. Aggiungere un calibro della massa

Passi Istruzioni dettagliate Commenti

1 Integrare ed estrarre lo spettro del 
picco da 
MSD_mix_4stds_DG_spl200_03.d.

a Contrassegnare la casella di controllo 
a fianco di 
MSD_mix_4stds_DG_spl200_03.D 
nella finestra Data Navigator.

b Selezionare Edit > Show > Only 
Highlighted.

c Selezionare Chromatograms > 
Integrate e Extract Peak Spectra.

d Chiudere la finestra Method Editor.

2 Aggiungere il calibro allo spettro 
del picco creato nell'attività 
precedente.

a Nella finestra MS Spectrum Results, 
selezionare lo strumento Delta Mass 
Caliper ( ) nella barra degli 
strumenti.

b (opzionale) Selezionare Profile Point 
to Point per scegliere il tipo di calibro 
nella barra degli strumenti Caliper.

c Ingrandire tra 66 e 132 m/z.
d Spostare il cursore nel punto del 

riquadro dello spettro in cui si vuole 
aggiungere il calibro.

e Spostare il cursore alla fine del calibro 
all'interno dello spettro. Man mano 
che si trascina il cursore, il valore della 
massa del delta cambia. Il calibro viene 
aggiunto nel momento in cui si rilascia 
il mouse. 

• Il cursore si trasforma in una 
freccia. Utilizzare questo cursore 
per selezionare il punto di inizio e di 
fine del calibro. 

• Non è possibile selezionar e il tipo 
di calibro se lo spettro si trova nel 
baricentro, poiché l'opzione Profile 
Point to Point non avrebbe effetto 
su questo tipo di dati.

• Il cursore a forma di "triangolo" 
compare sul punto più alto del picco 
selezionato.
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3 Modificare il calibro per utilizzare 
un colore diverso.

a Selezionare il calibro creato nel passo 
precedente.

b Fare clic sul pulsante Caliper 
Properties ( ) nella barra degli 
strumenti MS Spectrum Results 
Caliper.

c (opzionale) Digitare i valori Start X e 
Start Y.

d Selezionare Text color.
e Selezionare Font style e Font size.
f Fare clic su OK.

• Ad uno spettro è possibile 
aggiungere più di un calibro.

• Utilizzare le icone nella barra degli 
strumenti Caliper per selezionare 
tutti i calibri, eliminarli o modificarli.

Figura 28 Finestra di dialogo Delta Mass Caliper Settings e finestra MS Spectrum Results window

4 Eliminare i risultati 
dell'integrazione e gli spettri.

a Selezionare Chromatograms > Clear 
Results > Include Peak Spectra.

b Fare clic sullo strumento Range 
Select.

• Per salvare i calibri insieme ai 
risultati dei file di dati, vedere 
“Attività 17. Salvare i risultati” 
a pagina 64.

Attività 11. Aggiungere un calibro della massa (segue)

Passi Istruzioni dettagliate Commenti
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In queste attività, vengono ricercati e identificati i composti nel file di dati 
GC/MS.

Ciascun esercizio è riassunto in una tabella di tre colonne:

• Passi – Seguire tali istruzioni generali per procedere da soli e scoprire 
il programma.

• Istruzioni dettagliate – Seguire queste istruzioni in caso di dubbio o se 
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2 Ricerca e identificazione
Attività 12. Ricercare i composti mediante deconvoluzione cromatografica
Attività 12. Ricercare i composti mediante deconvoluzione 
cromatografica 

L'algoritmo FindCompounds identifica i composti nei dati GC/MS e crea uno 
spettro MS pulito per ciascun composto. Si tratta di un modo semplice per 
scavare a fondo nei dati complessi. È possibile utilizzare solo l'algoritmo Find 
Compounds by Chromatogram Deconvolution su dati campione GC/MS 
acquisiti con la modalità di scansione Scan, Product Ion scan o Neutral Loss.

Questa attività mostra come cercare i composti mediante deconvoluzione 
cromatografica con dati di massa precisi. È inoltre possibile cercare i composti 
mediante deconvoluzione cromatografica con dati di massa unitari dopo aver 
modificato la finestra di estrazione.

Attività 12. Ricercare i composti mediante Chromatogram Deconvolution (GC/MS)

Passaggio Istruzioni dettagliate Commenti

1 Aprire il TIC per il file di dati 
MSD_mix_4stds_DG_spl200_03.d.

a Se il programma non si apre, fare 
doppio clic sull'icona MassHunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati 
MSD_mix_4stds_DG_spl200_03.d nella 
cartella del file di dati d'esempio GC.

c Non contrassegnare la casella di 
controllo Load result data e 
selezionare Open.

• L'algoritmo Find Compounds by 
Chromatogram Deconvolution 
funziona sia con i file di dati 
GC/QQQ che GC/Q-TOF.

Figura 29 Cromatogramma TIC da Pest - 200 - Scan.d

2 Configurare l'interfaccia utente per 
utilizzare i dati GC.

• Seguire le istruzioni in “Attività 2. 
Configurare l'interfaccia utente per i 
dati GC/MS” a pagina 12.

• Per questi esempi, caricare il 
workflow GC/Q-TOF Compound 
Screening.
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3 Ricercare i composti utilizzando 
l'algoritmo di deconvoluzione 
cromatografica.
• Selezionare l'integratore Agile.
• Inserire una soglia SNR di 20.
• Inserire 100 ppm in Left m/z 

delta e Right m/z delta.

a Nella finestra Method Explorer, 
selezionare Find Compounds > Find 
by Chromatogram Deconvolution.

b Nella scheda Settings, alla voce Peak, 
digitare 20 come SNR threshold.

c Selezionare PPM come m/z delta 
units.

d Inserire 100 come Left m/z delta, 
100 come Right m/z delta.

• La sezione Find by Chromatogram 
Deconvolution è disponibile anche 
nella sezione GC/Q-TOF Compound 
Screening.

• In caso di dati di massa unitari, 
inserire 0,3 AMU come Left m/z 
delta e 0,7 AMU come Right m/z 
delta.

• È possibile estrarre tutti i risultati 
completi di un composto trovato 
selezionando le voci di menu 
Compounds > Extract Complete 
Result Set dopo aver evidenziato il 
composto.

Figura 30 Scheda Settings nella sezione Find by Chromatogram 
Deconvolution

Attività 12. Ricercare i composti mediante Chromatogram Deconvolution (GC/MS)

Passaggio Istruzioni dettagliate Commenti
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• Selezionare per estrarre gli 
spettri EIC, MS e MS/MS.

e Selezionare la scheda Results.
f Selezionare le caselle di controllo 

Extract EIC, Extract ECC, Extract 
cleaned spectrum e Extract raw 
spectrum.

g Fare clic su  per eseguire 
l'algoritmo Find Compounds by 
Chromatogram Deconvolution sul file 
di dati. 

h Se necessario, selezionare il comando 
View > Compound List.

• Con queste condizioni, il 
programma Qualitative Analysis 
trova 4 composti.

• Se il file di dati non è indicizzato, 
l'esecuzione dell'algoritmo 
potrebbe essere lunga.

4 Esaminare i composti. Vedere 
Figura 31 a pagina 49.

a Selezionare 2 nella casella Maximum 
number of list panes della barra degli 
strumenti MS Spectrum Results.

b Fare clic sull'icona Hide Empty 
Columns nella finestra Compound List.

c Selezionare il primo composto nella 
finestra Data Navigator. 

d Se la finestra Data Navigator è 
selezionata, utilizzare i tasti freccia per 
passare da un composto all'altro. 

• È utile visualizzare entrambi gli spettri 
perché in questo modo è possibile 
accedere a tutte le informazioni sul 
singolo composto.

• Notare che vengono visualizzati sia lo 
spettro pulito che quello grezzo.

Attività 12. Ricercare i composti mediante Chromatogram Deconvolution (GC/MS)

Passaggio Istruzioni dettagliate Commenti
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Figura 31 Risultati di Find Compounds by Chromatogram Deconvolution

Attività 12. Ricercare i composti mediante Chromatogram Deconvolution (GC/MS)

Passaggio Istruzioni dettagliate Commenti
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Attività 13. Identificare i composti mediante l'algoritmo Search Library
Attività 13. Identificare i composti mediante l'algoritmo Search Library

In questa attività si identificano e generano le formule per i composti trovati 
in “Attività 12. Ricercare i composti mediante deconvoluzione cromatografica” 
a pagina 46. È possibile eseguire questa attività se è stata acquistata la libreria 
NIST08.l o se si utilizza la libreria demo.l. Se si possiedono le due librerie, 
è possibile selezionarle entrambe.

Attività 13. Identificare i composti mediante l'algoritmo Search Library

Passaggio Istruzioni dettagliate Commenti

1 Utilizzare una libreria per ricercare 
tutti i composti nel file di dati 
MSD_mix_4stds_DG_spl200_03.d.

a Evidenziare i composti del file di dati 
MSD_mix_4stds_DG_spl200_03.D 
nella finestra Data Navigator.

b Nella finestra Method Explorer, 
selezionare Identify Compounds > 
Search Unit Mass Library.

c Nella scheda Settings, fare clic sul 
pulsante Add Library. Selezionare la 
libreria demo.l e fare clic sul pulsante OK.

d (opzionale) Nella scheda Settings, fare 
clic sul pulsante Add Library. 
Selezionare la libreria NIST08.l e fare 
clic sul pulsante OK.

e Selezionare la scheda Search Results.
f (opzionale) Selezionare Stop When 

Found per Multi-Library search type.
g Fare clic su Identify > Search Library 

for Compounds dal menu principale. 
Oppure, selezionare l'icona Search 
Library for Compounds icon  per 
eseguire l'algoritmo.

h Selezionare View > Difference Results.
i Selezionare View > Structure Viewer.
j Selezionare View > Compound 

Identification Results se necessario, 
per visualizzare la finestra.

k Se necessario, selezionare la scheda 
per la finestra Compound 
Identification Results. Questa finestra 
è una scheda della finestra 
Chromatogram Results.

• È possibile anche fare clic su 
GC/Q-TOF Compound Screening > 
Identify by Library Search in Method 
Explorer. Si apre la stessa sezione 
della finestra Method Editor.

• Le librerie Demo.l e Nist08 devono 
essere installate nella cartella \
MassHunter\Library.

• Molti dei composti vengono 
identificati eseguendo la ricerca con 
la libreria NIST08.l.

• Se non si dispone della libreria 
NIST08.l, selezionarne un'altra se 
disponibile.

• Se sono state scelte due o più librerie 
e si seleziona Stop When Found, 
l'algoritmo di ricerca esegue la ricerca 
nella prima libreria dell'elenco. Se il 
composto viene identificato, la ricerca 
si arresta. Se il composto non viene 
identificato, la ricerca prosegue nella 
libreria successiva fino 
all'identificazione del composto e 
termina nell'ultima libreria.

• Utilizzare il programma Library Editor 
per modificare le librerie che si 
utilizzano con l'algoritmo Search Unit 
Mass Library. Questo programma 
viene installato insieme al programma 
Agilent MassHunter Quantitative 
Analysis. Fare clic sull'icona  
per avviare il programma.
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2 Visualizzare le colonne Spectral 
Library Results nella finestra 
Compound List e nella finestra 
Compound Identification Results.

a Fare clic sul pulsante Show Library 
Search Columns ( ) nella barra 
degli strumenti Compound List e nella 
barra degli strumenti Compound 
Identification Results.

b Fare clic sul pulsante Hide Empty 
Columns ( ) nella barra degli 
strumenti Compound List e nella 
finestra Compound Identification 
Results.

Figura 32 Composti nel file di dati MSD_mix_4stds_DG_spl200_03.D e risultati della ricerca nella libreria 

3 Passare a Compound Details View 
per rivedere i composti.

a Selezionare  
nella barra degli strumenti principale.

b Chiudere la finestra Compound 
Fragment Spectrum Results.

Attività 13. Identificare i composti mediante l'algoritmo Search Library

Passaggio Istruzioni dettagliate Commenti
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Attività 13. Identificare i composti mediante l'algoritmo Search Library
4 Rivedere i risultati in Compound 
Details View.

a Fare clic sull'icona Overlaid nella 
finestra Compound Chromatogram 
Results.

b Espandere i risultati nella finestra 
Compound Identification Results.

• Nella Guida in linea sono disponibili 
altre informazioni su Compound 
Details View. Compound Details View 
è molto utile per rivedere i risultati 
ottenuti mediante l'algoritmo Find by 
Formula con un file di dati acquisito in 
modalità All Ions.

Figura 33 Compound Details View e composti nel file di dati MSD_mix_4stds_DG_spl200_03.D

5 Tornare a Navigator View. • Premere il pulsante 
 nella barra degli 

strumenti principale.

6 Chiudere il file di dati. a Selezionare File > Close Data File.
b Fare clic su No.

• Per salvare questi risultati, vedere 
“Attività 17. Salvare i risultati” 
a pagina 64.

Attività 13. Identificare i composti mediante l'algoritmo Search Library

Passaggio Istruzioni dettagliate Commenti
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Attività 14. Ricercare i composti mediante MRM (solo MRM)

L'algoritmo Find Compounds by MRM identifica i composti nei dati MRM di un 
triplo quadrupolo. L'algoritmo ricerca i composti utilizzando le transizioni 
MRM. Tutte i composti nel metodo di acquisizione vengono estratti e 
visualizzati in Compound List. I composti non vengono eliminati sulla base dei 
risultati di integrazione del cromatogramma. È possibile utilizzare l'algoritmo 
Find Compounds by MRM soltanto su dati acquisiti mediante transizioni 
MRM. L'algoritmo MRM utilizza le informazioni trovate nel file di dati se il file 
di dati è un file MRM.

Attività 14. Ricercare i composti mediante MRM (solo MRM)

Passaggio Istruzioni dettagliate Commenti

1 Aprire il TIC per il file di dati Pest - 
STD 200 MRM.d.

a Se il programma non si apre, fare 
doppio clic sull'icona Mass Hunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati Pest - STD 
200 MRM.d nella cartella di file 
d'esempio GC.

c Non contrassegnare la casella di 
controllo Load result data e 
selezionare Open.

• Utilizzare il workflow General 
quando si lavora con dati GC/QQQ. 
Se si lavora con i dati GC/Q-TOF è 
invece possibile utilizzare il 
workflow General o GC/Q-TOF 
Compound Screening.

Figura 34 Cromatogramma TIC da Pest - STD 200 MRM.d

2 Configurare l'interfaccia utente per 
utilizzare i dati GC.

• Seguire le istruzioni in “Attività 2. 
Configurare l'interfaccia utente per i 
dati GC/MS” a pagina 12.
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3 Ricercare i composti utilizzando 
l'algoritmo MRM.

a Nella finestra Method Explorer, 
selezionare Find Compounds > Find 
by MRM.

b Premere il pulsante Group transitions 
by compound name.

c Selezionare la scheda Integrator.
d Selezionare l'integratore Agile.

• È possibile scegliere la regione del 
cromatogramma su cui eseguire la 
ricerca dei composti. 

• È possibile estrarre tutti i risultati 
completi di un composto trovato 
selezionando le voci di menu 
Compounds > Extract Complete 
Result Set dopo aver evidenziato il 
composto.

Figura 35 Scheda Integrator nella sezione Find by MRM di Method Editor

e Fare clic su  per eseguire l'algoritmo 
Find Compounds by MRM sul file di dati. 

f Se necessario, selezionare il comando 
View > Compound List.

g Se necessario, selezionare il comando 
View > Compound Identification 
Results.

• Con queste condizioni, il 
programma Qualitative Analysis 
trova 28 composti.

4 Esaminare i composti. Vedere 
Figura 36 a pagina 55.

a Selezionare 2 nella casella Maximum 
number of list panes della barra degli 
strumenti MS Spectrum Results.

b Fare clic sull'icona Automatically 
Show Columns nella finestra 
Compound List e nella finestra 
Compound Identification Results.

c Selezionare il primo composto nella 
finestra Data Navigator. 

d Se la finestra Data Navigator è 
selezionata, utilizzare i tasti freccia per 
passare da un composto all'altro. 

• Lo ione precursore è visualizzato 
nella colonna Precursor (Acq 
Method) e lo ione prodotto nella 
colonna Product (Acq Method) della 
finestra Compound Identification 
Results.

Attività 14. Ricercare i composti mediante MRM (solo MRM)

Passaggio Istruzioni dettagliate Commenti
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Figura 36 Risultati dell'algoritmo Find by MRM

5 Chiudere il file di dati. a Selezionare File > Close Data File.
b Fare clic su Close.

• Per salvare questi risultati, vedere 
“Attività 17. Salvare i risultati” 
a pagina 64.

Attività 14. Ricercare i composti mediante MRM (solo MRM)

Passaggio Istruzioni dettagliate Commenti
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Attività 15. Ricercare i composti mediante l'integrazione

L'algoritmo Find Compounds by Integration identifica i composti sulla base 
dei risultati dell'integrazione. Per ogni picco identificato dall'integratore, 
viene creato un composto.

Attività 15. Ricercare i composti mediante l'integrazione

Passaggio Istruzioni dettagliate Commenti

1 Aprire il TIC per il file di dati 
MSD_mix_4stds_DG_spl200_03.D.

a Se il programma non si apre, fare 
doppio clic sull'icona Mass Hunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati Pest - STD 
200 MRM.d nella cartella di file 
d'esempio GC.

c Non contrassegnare la casella di 
controllo Load result data e 
selezionare Open.

• Utilizzare il workflow General 
quando si lavora con dati GC/QQQ. 
Se si lavora con i dati GC/Q-TOF è 
invece possibile utilizzare il 
workflow General o GC/Q-TOF 
Compound Screening.

Figura 37 Cromatogramma TIC da MSD_mix_4stds_DG_spl200_03.d

2 Configurare l'interfaccia utente per 
utilizzare i dati GC.

• Seguire le istruzioni in “Attività 2. 
Configurare l'interfaccia utente per i 
dati GC/MS” a pagina 12.

3 Ricercare i composti utilizzando 
l'algoritmo dell'integrazione.

a Nella finestra Method Explorer, 
selezionare Find Compounds > Find 
by Integration.

b Selezionare l'integratore MS/MS 
(GC).

• È possibile scegliere la regione del 
cromatogramma su cui eseguire la 
ricerca dei composti. 

• È possibile estrarre tutti i risultati 
completi di un composto trovato 
selezionando le voci di menu 
Compounds > Extract Complete 
Result Set dopo aver evidenziato il 
composto.
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Figura 38 Scheda Integrator nella sezione Find by Integration di Method Editor

c Fare clic su  per eseguire 
l'algoritmo Find Compounds by 
Integrationsul file di dati. 

d Se necessario, selezionare il comando 
View > Compound List.

• Con queste condizioni, il 
programma Qualitative Analysis 
trova 6 composti.

4 Esaminare i composti. Vedere 
Figura 36 a pagina 55.

a Selezionare 2 nella casella Maximum 
number of list panes della barra degli 
strumenti MS Spectrum Results.

b Fare clic sull'icona Automatically 
Show Columns nella finestra 
Compound List.

c Selezionare il primo composto nella 
finestra Data Navigator. 

d Se la finestra Data Navigator è 
selezionata, utilizzare i tasti freccia per 
passare da un composto all'altro. 

Attività 15. Ricercare i composti mediante l'integrazione

Passaggio Istruzioni dettagliate Commenti
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Figura 39 Risultati dell'algoritmo Find by Integration

5 Chiudere il file di dati. a Selezionare File > Close Data File.
b Fare clic su Close.

• Per salvare questi risultati, vedere 
“Attività 17. Salvare i risultati” 
a pagina 64.

Attività 15. Ricercare i composti mediante l'integrazione

Passaggio Istruzioni dettagliate Commenti
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Attività 16. Generare formule e libreria di ricerca per gli spettri 
del picco

In questa attività vengono innanzitutto integrati ed estratti gli spettri del picco 
dal file di dati GC/Q-TOF. Dopo di ché è possibile generare delle formule per 
ciascun spettro del picco.

Attività 16. Generare formule e libreria di ricerca per gli spettri del picco

Passaggio Istruzioni dettagliate Commenti

1 Aprire il TIC per il file di dati 
MSD_mix_4stds_DB_spl200_03.d.

a Se il programma non si apre, fare 
doppio clic sull'icona Mass Hunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati 
MSD_mix_4stds_DB_spl200_03.d 
nella cartella del file di dati d'esempio 
GC.

c Non contrassegnare la casella di 
controllo Load result data e 
selezionare Open.

• Se la casella Load result data non è 
disponibile, i risultati non sono stati 
salvati nel file di dati. Vedere 
“Attività 17. Salvare i risultati” 
a pagina 64 per le istruzioni sul 
salvataggio dei risultati.

2 Integrare ed estrarre gli spettri del 
picco.

a Selezionare la sezione Chromatograms 
> Integrate (MS) nella finestra Method 
Explorer.

b Selezionare la scheda Peak Filters.
c Premere il pulsante Peak height.
d Contrassegnare la casella di controllo 

Relative height.
e Selezionare la casella Limit (by 

height) to the largest e digitare 4.
f Selezionare Chromatograms > 

Integrate e Extract Peak Spectra.
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3 Generare le formule per ciascun 
spettro del picco.
• Visualizzare Spectrum 

Identification Results List.
• Chiudere la finestra MS 

Spectrum Results.

Suggerimento: Per ottenere gli stessi 
risultati della Figura 41, controllare di 
aver selezionato Common organic 
molecules come Isotope model.

a Nella finestra Method Explorer, 
selezionare Identify Compounds > 
Generate Formulas.

b Nella finestra Method Editor, 
selezionare la scheda Charge State e 
scegliere Common organic molecules 
come Isotope model.

c Nella finestra Data Navigator, 
evidenziare tutti gli spettri nella 
sezione User Spectra.

d Selezionare il comando Identify > 
Generate Formulas from Spectrum 
Peaks o premere il pulsante Generate 
Formulas from Spectrum Peaks  
per eseguire l'algoritmo.

e Se necessario, fare clic sull'icona 
Spectrum Identification Results , o 
selezionare il comando View > 
Spectrum Identification Results.

f Nella finestra Spectrum Identification 
Results, premere il pulsante 
Automatically Show Columns nella 
barra degli strumenti.

g Fare clic sull'icona Hide Empty 
Columns  nella finestra Spectrum 
Identification Results.

h Selezionare C6 H13 come risultato 
Best.

i Espandere la tabella per quella riga.
j Chiudere la finestra Method Editor.
k Rivedere le formule e le specie di ioni 

visualizzate sopra molti picchi nella 
finestra MS Spectrum Results. Tutte le 
formule e le specie di ioni sono dello 
stesso colore dello spettro.

• È possibile visualizzare i rapporti di 
abbondanza isotopica previsti sul 
grafico dello spettro ingrandendo il 
valore m/z corrispondente. 
Consultare il Guida in linea per 
ulteriori informazioni.

• L'icona Run  nella barra degli 
strumenti Method Editor consente 
talvolta di selezionare un'azione da 
una serie possibile. Ad esempio, 
facendo clic sull'icona Run in 
questa sezione, le azioni possibili 
sono due. Fare clic sulla freccia per 
visualizzare le azioni possibili e 
scegliere quella desiderata. 
Selezionando un'azione diversa si 
modifica l'azione predefinita. 
Premere semplicemente il pulsante 
Run per eseguire l'azione 
predefinita.

• La larghezza di una colonna può 
essere modificata trascinando la 
linea che la separa dalle colonne a 
fianco.

• È possibile spostare una colonna 
trascinandone la testata.

• Una colonna può essere eliminata 
selezionando Remove column dal 
menu di scelta rapida della tabella.

Attività 16. Generare formule e libreria di ricerca per gli spettri del picco

Passaggio Istruzioni dettagliate Commenti
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Figura 40 Risultati di Generate Formula per picchi da 1 a 4

4 Eseguire una ricerca nella libreria 
per gli spettri dei picchi da 1 a 4

a Nella finestra Data Navigator, fare clic 
su User Spectra.

b Nella finestra Method Explorer, 
selezionare Identify Compounds > 
Search Unit Mass Library.

c Controllare che la libreria selezionata 
sia valida.

d Fare clic su Identify > Search Library 
for Spectra dal menu principale.

e Chiudere la finestra Method Editor.

• La finestra Method Editor si apre 
automaticamente selezionando una 
sezione in Method Explorer.

Attività 16. Generare formule e libreria di ricerca per gli spettri del picco

Passaggio Istruzioni dettagliate Commenti
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5 Modificare le colonne visualizzate. a Selezionare con il tasto destro la 
finestra Spectrum Identification 
Results e fare clic su Add/Remove 
Columns. Nella finestra di dialogo 
“(Enhanced) Add/Remove Columns”, 
contrassegnare le colonne da 
visualizzare. Fare clic su OK.

b Chiudere la finestra Method Editor.
c Fare clic sull'icona Hide Empty 

Columns  nella finestra Spectrum 
Identification Results.

d Rivedere le formule e le specie di ioni 
visualizzate sopra ciascun picco nella 
finestra MS Spectrum Results.

• Se si utilizza il comando Remove 
Column e si rimuove una colonna 
che contiene dati, il software 
rivisualizza automaticamente 
questa colonna se è attiva la 
funzione Automatically Show 
Columns.

• L'algoritmo LibSearch è prioritario 
nella sezione Combine 
Identification Results del metodo. È 
possibile scegliere manualmente il 
risultato MFG migliore o modificare 
il sistema di combinazione dei 
risultati dell'identificazione.

Figura 41 Risultati di Library Search e Generate Formulas per gli spettri dei primi picchi

Attività 16. Generare formule e libreria di ricerca per gli spettri del picco

Passaggio Istruzioni dettagliate Commenti
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6 Rivedere i risultati di ciascun 
spettro nella finestra MS Peaks 
One.

a Selezionare View >MS Spectrum 
Peak List 1.

b Selezionare con il tasto destro 
Add/Remove Columns.

c Controllare che le colonne in 
Figura 42 sia nell'elenco Show these 
columns.

d Classificare selezionando la colonna 
Ion Type.

e Se il tipo di ione e uno ione 
frammentato, le formule e le specie di 
ioni visualizzate sono indicate in vede 
su ciascun picco nella finestra MS 
Spectrum Results.

• Gli ioni frammentati sono indicati in 
verde nella finestra MS Spectrum 
Results.

• Le opzioni per Ion Type sono 
Molecular Ion, Fragment Ion o 
nessuno. Scegliendo l'opzione 
Fragment Ion, la colonna Loss 
Formula and Loss Mass contiene la 
formula e la massa che necessarie 
per ottenere questo ione dallo ione 
molecolare. In Formula & Ion 
Species sono indicate le formule e 
le specie di ioni per questo tipo di 
ione.

Figura 42 Tabella MS Peaks One con le colonne Ion Type, Loss Formula, Loss Mass, 
e Formula & Ion Species

7 (opzionale) Chiudere il file di dati.
• Passare all'attività successiva 

per informazioni sulla procedura 
di salvataggio dei risultati.

a Selezionare File > Close Data File.
b Fare clic su Close.

• Per salvare questi risultati, vedere 
“Attività 17. Salvare i risultati” 
a pagina 64.

Attività 16. Generare formule e libreria di ricerca per gli spettri del picco

Passaggio Istruzioni dettagliate Commenti
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Attività 17. Salvare i risultati

In questa attività, vengono salvati i risultati del file di dati corrente.

Attività 17. Salvare i risultati

Passaggio Istruzioni dettagliate Commenti

1 Salvare i risultati del file di dati 
corrente e chiudere il file di dati.

a Selezionare File > Save Results.
b Selezionare File > Close Data File.

• Per un file di dati è possibile salvare 
una sola serie di risultati. Se sono 
già stati salvati dei risultati per 
questo file di dati, tali risultati 
saranno sovrascritti nel momento in 
cui si seleziona File > Save Results.

2 Aprire il file di dati e caricare i 
risultati.

a Selezionare File > Open Data File. Si 
apre la finestra di dialogo “Open Data 
File”.

b Scegliere un file di dati. Selezionare ad 
esempio il file di dati 
MSD_mix_4stds_DG_spl200_03.d.

c Contrassegnare la casella di controllo 
Load result data.

d Fare clic sul pulsante Open.
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Figura 43 Finestra di dialogo Open Data File 

3 Esaminare i risultati. a Selezionare la finestra Spectrum 
Identification Results.

b Rivedere i risultati.

•

Attività 17. Salvare i risultati

Passaggio Istruzioni dettagliate Commenti

Casella di controllo Load result contrassegnata.
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Attività 17. Salvare i risultati
Figura 44 Risultati di Library Search e Generate Formulas per gli spettri dei primi picchi

4 Chiudere il file di dati. a Selezionare File > Close Data File.
b Fare clic su Close.

5 Riaprire il file di dati e non caricare 
i risultati.

a Selezionare File > Open. Si apre la 
finestra di dialogo “Open Data File”.

b Scegliere un file di dati. Selezionare ad 
esempio il file di dati 
MSD_mix_4stds_DG_spl200_03.d.

c Deselezionare la casella di controllo 
Load result data.

d Fare clic sul pulsante Open.

• Se i risultati non vengono caricati, 
per impostazione predefinita il 
programma apre un TIC all'apertura 
di un file di dati. Se si contrassegna 
la casella di controllo Run ‘File 
Open’ actions from selected 
method, vengono eseguite le azioni 
di File Open. Consultare il Guida in 
linea per ulteriori informazioni.

Attività 17. Salvare i risultati

Passaggio Istruzioni dettagliate Commenti
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Attività 17. Salvare i risultati
Figura 45 Risultati di Library Search e Generate Formulas per gli spettri dei primi picchi

6 Chiudere il file di dati. a Selezionare File > Close Data File.
b Fare clic su Close.

Attività 17. Salvare i risultati

Passaggio Istruzioni dettagliate Commenti
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Attività 17. Salvare i risultati
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In questa attività viene spiegato come impostare ed eseguire un metodo di 
analisi qualitativa. All'apertura del file di dati, vengono eseguite le azioni 
all'interno del metodo automatico. 

Per questi esempi vengono utilizzati due diversi workflow. Per ulteriori 
informazioni vedere “Workflow” a pagina 97.

Il workflow General supporta i dati GC/QQQ, GC/Q-TOF e LC/MS. Il workflow 
GC/Q-TOF Compound Screening supporta i dati GC/Q-TOF.

Ciascun esercizio è riassunto in una tabella di tre colonne:

• Passi - Seguire tali istruzioni generali per procedere da soli e scoprire il 
programma.

• Istruzioni dettagliate - Seguire queste istruzioni in caso di dubbio o se si 
preferisce procedere gradatamente alla conoscenza del programma.

• Commenti – Consigli e informazioni aggiuntive su ciascun passo 
dell'esercitazione.
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Attività 18. Impostare ed eseguire un metodo di analisi qualitativa 
mediante il workflow General

Se si utilizza il programma Qualitative Analysis per la prima volta, viene 
caricato il metodo default.m. È possibile apportare delle modifiche al metodo 
aperto e salvarlo, oppure si può aprire un metodo nuovo, modificarlo e 
salvarlo. Il metodo default.m. non può essere sovrascritto.

Inoltre, è possibile impostare determinate azioni per il metodo da eseguire 
all'apertura di un file di dati. Quando si apre un file di dati, è possibile anche 
caricare il metodo che è stato utilizzato per creare i risultati memorizzati 
insieme al file di dati. Questo metodo viene salvato automaticamente ogni 
volta che si salvano i dati con il file di dati. Il workflow General può essere 
utilizzato con i file di dati GC/MS o LC/MS.

Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General

Passi Istruzioni dettagliate Commenti

1 Aprire il TIC per il file di dati Pest - 
STD 200 MRM.d.

a Se il programma non si apre, fare 
doppio clic sull'icona Mass Hunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati Pest - STD 
200 MRM.d nella cartella di file 
d'esempio GC.

c Non contrassegnare la casella di 
controllo Load result data e 
selezionare Open.

• Se si lavora con i dati GC/MS è 
invece possibile utilizzare il 
workflow General o GC/Q-TOF 
Compound Screening.

2 Configurare l'interfaccia utente per 
utilizzare i dati GC.

• Seguire le istruzioni in “Attività 2. 
Configurare l'interfaccia utente per i 
dati GC/MS” a pagina 12.

• Per questo esempio, selezionare il 
workflow General.

3 Impostare il metodo per estrarre un 
cromatogramma TIC. 
• Definire un cromatogramma TIC 

per i dati MS.

a Nella finestra Method Explorer, 
selezionare Chromatogram > Define 
Chromatograms.

b Eliminare il cromatogramma BPC.
c Selezionare TIC come Type.
d Controllare che MS Level sia su 

MS/MS.
e Fare clic su Add.
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Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General
4 Modificare il metodo per integrare i 
dati.
• Limitare l'integrazione ai quattro 

picchi più alti.

a Nella finestra Method Explorer, 
selezionare Chromatogram > 
Integrate (MS/MS).

b Selezionare la scheda Peak Filters.
c Nella sezione Maximum number of 

peaks, contrassegnare la casella di 
controllo Limit (by height) to the 
largest.

d Digitare 4. 

• Se si aggiorna un valore nella 
scheda Peak Filters della sezione 
Chromatogram > Integrate (MS) 
vengono aggiornati anche i valodi di 
altre sezioni di Method Explorer. 
Compaiono dei triangoli blu che 
visualizzano altre sezioni.

Figura 46 Scheda Chromatogram > Integrate (MS/MS) > Peak Filters 

5 Controllare l'integrazione per 
assicurarsi che vengano 
visualizzati solo i 4 picchi integrati.

• Fare clic sull'icona Integrate 
Chromatogram  per integrare il 
file di dati. 

6 Salvare il metodo con il nome 
iii_GCexercise1, dove iii” stanno 
per le iniziali dell'operatore.

a Dal menu in alto, selezionare 
Method > Save As.

b Digitare iii_GCexercise1.
c Fare clic sul pulsante Save.

• Quando si salva il metodo, tutti i 
triangoli blu che stanno ad indicare 
valori modificati nel metodo aperto 
scompaiono.

7 Modificare il fondo dello spettro 
del picco per utilizzare lo spettro 
all'inizio di un picco.

a Nella finestra Method Explorer, 
selezionare Spectrum > Extract 
(MS/MS).

b Selezionare Peak Spectrum 
Extraction (MS/MS).

c In Peak spectrum background, 
selezionare Spectrum at peak start.

• Se si apportano ulteriori modifiche 
dopo aver salvato il metodo, 
i triangoli blu vengono nuovamente 
visualizzati.

Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General

Passi Istruzioni dettagliate Commenti

Per salvare il metodo 
corrente è possibile 
selezionare l'icona Save 
Method.
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Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General
Figura 47 Scheda Spectrum > Extract (MS/MS) > Peak Spectrum Extraction (MS/MS) 

8 Controllare l'estrazione dello 
spettro MS per assicurarsi che lo 
spettro di fondo sia sottratto.

• Fare clic sull'icona Extract Peak 
Spectrum  per eseguire l'azione 
sul picco selezionato nel file di dati. 

9 Salvare il metodo. • È possibile salvare il metodo in tre 
modi:
• Selezionare l'icona Save 

Method in Method Editor.
• Fare clic con il tasto destro 

su Method Editor, e selezionare 
Save Method.

• Dal menu in alto, selezionare 
Method > Save.

• L'icona Save Method è illustrata 
nella Figura 47 a pagina 72

10 Impostare il metodo per 
automatizzare le azioni (i cui 
parametri sono stati appena 
modificati) all'apertura di un file di 
dati.
• Elencare le azioni da eseguire 

all'apertura di questo o di un 
altro file di dati.

Suggerimento: vedere la voce General 
in Method Explorer.

a Nella finestra Method Explorer, 
selezionare General > File Open 
Actions.

b Selezionare Integrate and Extract 
Peak Spectra dall'elenco Available 
actions. 

c Premere il pulsante Add, , per 
spostare l'azione selezionata 
nell'elenco Actions to be run. 
È anche possibile fare doppio clic 
sull'azione selezionata per spostarla 
nell'altro elenco.

Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General

Passi Istruzioni dettagliate Commenti

Per salvare il metodo 
corrente è possibile 
selezionare l'icona Save 
Method.
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Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General
11 Controllare File Open Actions. • Fare clic sull'icona Run File Open 
Actions Now  per eseguire le 
azioni sul file di dati. 

• I cromatogrammi e gli spettri non 
vengono sovrascritti. Vengono 
aggiunti nuovi cromatogrammi e 
nuovi spettri.

Figura 48 Sezione General > File Open Actions in Method Editor

12 Salvare il metodo. • Selezionare l'icona Save Method nella 
finestra Method Editor.

13 Impostare il metodo per 
automatizzare le azioni 
all'esecuzione del metodo durante 
una lista di lavoro.
• Elencare le azioni da eseguire 

all'apertura di questo o di un 
altro file di dati.

Suggerimento: vedere la voce Worklist 
Automation nella finestra Method 
Explorer

a Nella finestra Method Explorer, 
selezionare Worklist Automation > 
Worklist Actions.

b Rimuovere Generate Analysis Report 
dall'elenco Actions to be run.

14 Controllare Worklist Actions. • Fare clic sull'icona Run Worklist 
Actions Now  per eseguire le 
azioni sul file di dati. 

• I cromatogrammi e gli spettri non 
vengono sovrascritti. Vengono 
aggiunti nuovi cromatogrammi 
e nuovi spettri.

Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General

Passi Istruzioni dettagliate Commenti

Nell'elenco Actions to be run sono 
visualizzate due azioni diverse. 
La prima azione deve estrarre i 
cromatogrammi definiti, poi il 
cromatogramma viene integrato e 
i picchi vengono estratti.
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Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General
Figura 49 Sezione Worklist Automation > Worklist Actions in Method Editor

15 Salvare il metodo e chiudere il file 
di dati senza salvare i risultati.

a Selezionare l'icona Save Method in 
Method Editor.

b Selezionare File > Close Data File,, 
quindi scegliere No quando il sistema 
chiede di salvare i risultati.

Attività 18. Impostare ed eseguire un metodo di analisi qualitativa mediante il workflow General

Passi Istruzioni dettagliate Commenti

In un metodo sono presenti due 
diversi elenchi di azioni. Il primo 
elenco di azioni (File Open 
Actions) può essere eseguito 
all'apertura di un file di dati. Il 
secondo elenco di azioni 
(Worklist Actions) viene attuato 
all'esecuzione del metodo.
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Attività 19. Impostare ed eseguire un metodo mediante il workflow 
GC/Q-TOF Compound Screening

In questa attività viene impostato un metodo di analisi qualitativa che 
contiene una serie di azioni analitiche da eseguire in una data sequenza. Tra le 
azioni possibili, l'estrazione e l'integrazione di cromatogrammi, l'estrazione di 
spettri, la ricerca di spettri del picco in una libreria, la generazione di formule 
per gli spettri e la stampa di un rapporto di analisi.

Attività 19. Impostare ed eseguire un metodo mediante il workflow GC/Q-TOF Compound Screening

Passi Istruzioni dettagliate Commenti

1 Aprire il TIC per il file di dati 
MSD_mix_4stds_DG_spl200_03.d.

a Se il programma non si apre, fare 
doppio clic sull'icona Mass Hunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati 
MSD_mix_4stds_DG_spl200_03.d 
nella cartella del file di dati d'esempio 
GC.

c Non contrassegnare la casella di 
controllo Load result data e 
selezionare Open.

2 Configurare l'interfaccia utente per 
utilizzare i dati GC.

• Seguire le istruzioni in “Attività 2. 
Configurare l'interfaccia utente per i 
dati GC/MS” a pagina 12.

• Per questo esempio, selezionare il 
workflow GC/Q-TOF Compound 
Screening.

3 Controllare che sia estratto un TIC. a Nella finestra Method Explorer, 
selezionare Chromatogram.

b Selezionare la sezione Define 
Chromatograms.

c Nella finestra Method Editor, 
controllare che il cromatogramma 
nella sezione Defined chromatograms 
sia un TIC. Altrimenti, selezionare TIC 
in Type. Premere il pulsante Change.

•
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4 Rivedere i parametri dell'algoritmo 
Find by Chromatogram 
Deconvolution.

a Selezionare la sezione GC/Q-TOF 
Compound Screening > Find by 
Chromatogram Deconvolution nella 
finestra Method Explorer.

b Selezionare la scheda Mass Filter.
c Impostare il valore Absolute height su 

13000.
d Selezionare la scheda Results.
e Premere il pulsante Highlight all 

compounds.
f Rivedere i risultati su ciascuna scheda.

• Controllare le sezioni del workflow 
GC/Q-TOF Compound Screening.

• Notare la presenza di sei sezioni per 
questo workflow. Tutte queste 
sezioni sono duplicati di sezioni che 
appartengono già a Method 
explorer.

• I triangoli blu vengono visualizzati in 
altre sezioni di Method Explorer ad 
indicare che i valori dello stesso 
parametro sono stati cambiati 
anche da qualche altra parte.

5 Rivedere i parametri dell'algoritmo 
Identify by Library Search.

a Selezionare la sezione GC/Q-TOF 
Compound Screening > Identify by 
library search nella finestra Method 
Explorer.

b Premere il pulsante Add Library. 
Selezionare una libreria e fare clic su 
Open.

c (opzionale) Premere il pulsante 
Remove Library per rimuovere una 
libreria se non si intende utilizzarla.

d Rivedere i parametri su ciascuna 
scheda.

• Il file demo.l library o NIST08.l (o 
un'altra versione della libreria NIST) 
è installato nella cartella
\MassHunter\Library.

6 Salvare il metodo con il nome 
iii_GCexercise2, dove iii” stanno 
per le iniziali dell'operatore.

a Dal menu in alto, selezionare 
Method > Save As.

b Digitare iii_GCexercise2.
c Fare clic sul pulsante Save.

Attività 19. Impostare ed eseguire un metodo mediante il workflow GC/Q-TOF Compound Screening

Passi Istruzioni dettagliate Commenti
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7 Impostare il metodo per 
automatizzare le azioni all'apertura 
di un file di dati.
• Elencare le azioni da eseguire 

all'apertura di questo o di un 
altro file di dati.

Suggerimento: vedere la voce General 
nella finestra Method Explorer.

a Nella finestra Method Explorer, 
selezionare General > File Open 
Actions.

b Rimuovere Generate Analysis Report 
dall'elenco Actions to be run.

c Rimuovere Integrate and Extract Peak 
Spectra.

d Rimuovere qualsiasi altra azione 
dell'elenco.

e Aggiungere Extract Defined 
Chromatograms.

f Aggiungere Find Compounds by 
Chromatographic Deconvolution.

g Aggiungere Search Spectral Library 
for Compound.

8 Controllare File Open Actions. • Fare clic sull'icona Run ‘File Open’ 
Actions Now  per eseguire le 
azioni sul file di dati. 

• I cromatogrammi e gli spettri non 
vengono sovrascritti. Vengono 
aggiunti nuovi cromatogrammi e 
nuovi spettri.

Attività 19. Impostare ed eseguire un metodo mediante il workflow GC/Q-TOF Compound Screening

Passi Istruzioni dettagliate Commenti
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Attività 19. Impostare ed eseguire un metodo mediante il workflow GC/Q-TOF Compound Screening
Figura 50 Risultati delle azioni della lista di lavoro sui dati GC/Q-TOF

9 Salvare il metodo con il nome 
iii_GCexercise2, dove iii” stanno 
per le iniziali dell'operatore.

a Dal menu, selezionare Method > 
Save As.

b Digitare iii_GCexercise2.
c Selezionare Save.

• Se il metodo viene eseguito durante 
una lista di lavoro Data Acquisition, 
le Worklist Actions di questa 
scheda vengono condotte nella 
sequenza indicata.

10 Chiudere il file di dati senza salvare 
i risultati.

a Selezionare File > Close Data File.
b Selezionare No quando il sistema 

chiede di salvare i risultati.

Attività 19. Impostare ed eseguire un metodo mediante il workflow GC/Q-TOF Compound Screening

Passi Istruzioni dettagliate Commenti
78 Software Agilent MassHunter Workstation - Guida conoscitiva di Qualitative Analysis per LC/MS



Utilizzo di workflow, esportazione e stampa 3
Attività 20. Esportare un file CEF
Attività 20. Esportare un file CEF

È possibile esportare un file CEF che contiene informazioni sui composti. 
Il file CEF può essere importato in altri programmi come MassHunter 
Quantitative Analysis e Mass Profiler Professional. Si possono inoltre 
importare i composti che sono stati esportati in un file CEF.

Attività 20. Esportare un file CEF

Passi Istruzioni dettagliate Commenti

1 Aprire il file di dati 
MSD_mix_4stds_DG_spl200_03.d 
ed eseguire File Open actions per il 
metodo iii_GCexercise2.m creato 
in “Attività 19. Impostare ed 
eseguire un metodo mediante il 
workflow GC/Q-TOF Compound 
Screening” a pagina 75.

a Se il programma non si apre, fare 
doppio clic sull'icona Mass Hunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati 
MSD_mix_4stds_DG_spl200_03.d nella 
cartella del file di dati d'esempio GC.

c Deselezionare la casella di controllo 
Load result data.

d Contrassegnare la casella di controllo 
Run ‘File Open’ actions from selected 
method.

e Premere il pulsante Use current 
method e fare clic su Open.

• Se “Attività 19. Impostare ed 
eseguire un metodo mediante il 
workflow GC/Q-TOF Compound 
Screening” a pagina 75 è stata 
terminata, il metodo corrente è 
iii_GCexercise2.m. Questo metodo 
esegue l'algoritmo Find Compounds 
by Chromatogram Deconvolution e 
l'algoritmo Search Library su 
ciascun composto.

2 Esportare un file CEF. a Per esportare in modo interattivo il file, 
selezionare File > Export > as CEF.

b Premere il pulsate All results.
c Selezionare la posizione del file esportato.
d Fare clic su OK.

• Un file CEF viene utilizzato per 
esportare dei composti. 

Figura 51 Finestra di dialogo Export CEF Options 
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Attività 21. Stampare un rapporto di analisi

Seguire queste istruzioni per stampare un rapporto di analisi dopo aver 
concluso le attività di questa esercitazione o della successiva. 

Un rapporto di analisi può contenere i risultati dell'esportazione e 
dell'integrazione dei cromatogrammi, dell'estrazione degli spettri, della ricerca 
dei composti, della ricerca del database per gli spettri del picco e della 
generazione delle formule dagli spettri del picco. 

Attività 21. Stampare un rapporto di analisi

Passi Istruzioni dettagliate Commenti

1 Se il file 
MSD_mix_4stds_DG_spl200_03.d 
non è caricato, aprirlo ed eseguire 
File Open actions per il metodo 
iii_GCexercise2.m creato in 
“Attività 19. Impostare ed eseguire 
un metodo mediante il workflow 
GC/Q-TOF Compound Screening” 
a pagina 75.

a Se il programma non si apre, fare 
doppio clic sull'icona Mass Hunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati 
MSD_mix_4stds_DG_spl200_03.d 
nella cartella del file di dati d'esempio 
GC.

c Deselezionare la casella di controllo 
Load result data.

d Contrassegnare la casella di controllo 
Run ‘File Open’ actions from selected 
method.

e Premere il pulsante Use current 
method e fare clic su Open.

• Se “Attività 19. Impostare ed 
eseguire un metodo mediante il 
workflow GC/Q-TOF Compound 
Screening” a pagina 75 è stata 
terminata, il metodo corrente è 
iii_GCexercise2.m. Questo metodo 
esegue l'algoritmo Find Compounds 
by Chromatogram Deconvolution e 
l'algoritmo Search Library su 
ciascun composto.

2 Modificare le opzioni di seleziona 
del rapporto di analisi nel metodo:
• Contrassegnare le caselle di 

controllo dei cromatogrammi, 
degli spettri o delle tabelle da 
stampare.

• Deselezionare le caselle di 
controllo dei cromatogrammi, 
degli spettri o delle tabelle che 
non si intende stampare.

a Nella finestra Method Explorer, 
selezionare Reports > Analysis 
Report.

b Contrassegnare le caselle di controllo 
degli altri elementi da stampare

c Deselezionare le opzioni dei 
cromatogrammi e degli spettri che non 
si intende stampare.

• Il rapporto di analisi contiene solo le 
informazioni contrassegnate in 
questa sezione. 

• Se alcuni risultati non sono 
disponibili, non vengono inclusi 
nonostante siano stati 
contrassegnati in questa sezione. 
Ad esempio, se il cromatogramma 
non è stato integrato, la tabella dei 
picchi non sarà inclusa.
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Figura 52 Sezione Analysis Report nelle finestre Method Explorer e Method Editor

Attività 21. Stampare un rapporto di analisi (segue)

Passi Istruzioni dettagliate Commenti

Per impostazione predefinita, la 
finestra Method Editor è mobile. Viene 
visualizzata come finestra separata 
dal resto del programma Qualitative 
Analysis. Per ancorare la finestra, 
selezionare il titolo della finestra con 
il tasto destro del mouse e scegliere 
Floating. Per ancorarla è anche 
possibile fare doppio clic sulla barra 
del titolo.
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Attività 21. Stampare un rapporto di analisi
3 Stampare il rapporto. a Sono possibili diverse soluzioni per 
stampare il rapporto in modo 
interattivo:
• Da menu principale, selezionare 

File > Print > Analysis Report.
• Dalla barra degli strumenti 

principale, selezionare l'icona 
Printer.

• Fare clic sull'icona Print Analysis 
Report  nella barra degli 
strumenti Method Editor quando la 
sezione Analysis Report è 
selezionata.

• Fare clic con il tasto destro nella 
sezione Analysis Report in Method 
Editor, quindi selezionare Print 
Analysis Report.

• Menu di scelta rapida del file di dati 
in Data Navigator, selezionare 
Analysis Report.

b Selezionare Report contents.
c Contrassegnare la casella di controllo 

Print report e selezionare una 
stampante.

d Contrassegnare la casella di controllo 
Print preview.

e Premere il pulsante OK.

• L'icona Run  nella barra degli 
strumenti Method Editor consente 
talvolta di selezionare un'azione da 
una serie possibile. Ad esempio, per 
passare alla sezione Reports > 
Common Reporting Options nella 
finestra Method Editor, l'icona Run 
offre quattro azioni possibili da 
selezionare. Fare clic sulla freccia 
per visualizzare le azioni possibili e 
scegliere quella desiderata. 
Selezionando un'azione diversa si 
modifica l'azione predefinita. 
Premere semplicemente il pulsante 
Run per eseguire l'attuale azione 
predefinita.

Attività 21. Stampare un rapporto di analisi (segue)

Passi Istruzioni dettagliate Commenti
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Utilizzo di workflow, esportazione e stampa 3
Attività 21. Stampare un rapporto di analisi
Figura 53 Finestra di dialogo Print Analysis Report

f Rivedere il rapporto.
g Fare clic sull'icona Close Print 

Preview nella barra degli strumenti.

Figura 54 Finestra Print Preview con il rapporto di analisi

Attività 21. Stampare un rapporto di analisi (segue)

Passi Istruzioni dettagliate Commenti
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Attività 22. Stampare un rapporto sui composti
Attività 22. Stampare un rapporto sui composti

Seguire queste istruzioni per stampare un rapporto sui composti.

Attività 22. Stampare un rapporto sui composti

Passaggio Istruzioni dettagliate Commenti

1 Se il file 
MSD_mix_4stds_DG_spl200_03.d 
non è caricato, aprirlo ed eseguire 
File Open actions per il metodo 
iii_GCexercise2.m creato in 
“Attività 19. Impostare ed eseguire 
un metodo mediante il workflow 
GC/Q-TOF Compound Screening” 
a pagina 75.

a Se il programma non si apre, fare 
doppio clic sull'icona Mass Hunter 
Qualitative Analysis. Oppure, 
selezionare File > Open Data File.

b Selezionare il file di dati 
MSD_mix_4stds_DG_spl200_03.d 
nella cartella del file di dati d'esempio 
GC.

c Deselezionare la casella di controllo 
Load result data.

d Contrassegnare la casella di controllo 
Run ‘File Open’ actions from selected 
method.

e Premere il pulsante Use current 
method e fare clic su Open.

• Se “Attività 19. Impostare ed 
eseguire un metodo mediante il 
workflow GC/Q-TOF Compound 
Screening” a pagina 75 è stata 
terminata, il metodo corrente è 
iii_GCexercise2.m. Questo metodo 
esegue l'algoritmo Find Compounds 
by Chromatogram Deconvolution e 
l'algoritmo Search Library su 
ciascun composto.

2 Modificare alcune opzioni del 
metodo per il rapporto sui 
composti:
• Disattivare la visualizzazione 

degli spettri MS ingranditi su 
picchi specifici.

• Disattivare le opzioni MS/MS 
nel rapporto.

a In Method Explorer, selezionare 
Reports > Compound Report.

b Deselezionare la casella Show MS 
spectrum.

c Deselezionare la casella Show 
MS/MS spectrum.

d Deselezionare la casella how MS/MS 
peak table.

• Queste caselle consentono di 
specificare le informazioni da 
includere nel rapporto qualora siano 
disponibili. Se le informazioni non 
sono disponibili, la sezione 
specifica viene automaticamente 
saltata. Ad esempio, i risultati 
MS/MS non vengono mai inclusi se 
il file di dati contiene solo dati MS.
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Attività 22. Stampare un rapporto sui composti
Figura 55 Sezione Compound Report in Method Editor

3 (opzionale) Scegliere un modello di 
differente per il rapporto sui 
composti.

a Nella finestra Method Explorer, 
selezionare Reports > Common 
Reporting Options.

b Selezionare CompoundReport
WithIdentificationHits.xlsx in 
Compound report template.

• Il software offre diversi tipi di 
modelli per il rapporto.

• È possibile personalizzare un 
modello di rapporto utilizzando 
Excel e Report Designer.

Figura 56 Sezione Common Reporting Options in Method Editor

Attività 22. Stampare un rapporto sui composti

Passaggio Istruzioni dettagliate Commenti

La casella di controllo Overlay 
compound chromatograms non deve 
essere selezionata per i dati GC/Q-TOF.

Excel e Report Designer possono 
essere utilizzati per 
personalizzare qualsiasi modello 
con estensione XLTX. Non è 
possibile personalizzare il 
rapporto sul metodo di 
acquisizione.
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3 Utilizzo di workflow, esportazione e stampa
Attività 22. Stampare un rapporto sui composti
4 Stampare il rapporto. a Selezionare File > Print > Compound 
Report o fare clic sulla freccia 
dell'icona Print Analysis Report  e 
selezionare Print Compound Report 
per stampare il rapporto sui composti.

b Contrassegnare la casella di controllo 
Print preview.

c Fare clic su OK. Esaminare il rapporto.
d Selezionare l'icona Close Print 

Preview.

• Nella finestra di dialogo Print 
Compound Report, è possibile 
scegliere una stampante diversa, 
decidere se salvare il file in formata 
PDF o Excel, scegliere di salvare 
tutti i risultati o soltanto quelli 
evidenziati o decidere di combinare 
più file di dati in un rapporto.

• Consultare la Guida in linea o il DVD 
formativo di Report Designer per 
ulteriori informazioni.

Figura 57 Finestra Print Preview con il rapporto sui composti

5 Chiudere il file di dati senza salvare 
i risultati.

a Selezionare File > Close Data File.
b Selezionare No quando il sistema 

chiede di salvare i risultati.

Attività 22. Stampare un rapporto sui composti

Passaggio Istruzioni dettagliate Commenti
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4
Utilizzo delle finestre
Utilizzo delle finestre

Quando si apre il programma Qualitative Analysis per la prima volta, vengono 
visualizzate quattro finestre con il loro layout predefinito: Data Navigator, Method 
Explorer, Chromatogram Results e MS Spectrum Results. È possibile passare dalla 
finestra Navigator View a Compound Details View.

Utilizzando il menu View è possibile visualizzare altre diciassette finestre in 
Navigator View: 

• Method Editor - consente di modificare i parametri del metodo, in schede 
distinte

• Spectrum Preview - consente di scansionare rapidamente gli spettri in un 
file di dati

• MS Spectrum Results - visualizza gli spettri MS e MS/MS

• Difference Results - visualizza i risultati sulla differenza dopo aver eseguito 
una ricerca nella libreria

• Deconvolution Results - visualizza gli spettri deconvoluti

• Deconvolution Mirror Plot - visualizza due spettri deconvoluti in 
un'immagine speculare

• UV Spectrum Results - mostra gli spettri UV, disponibili solo per dati LC/MS

• Integration Peak List - visualizza i risultati dell'integrazione in una tabella

• MS Spectrum Peak List 1 - visualizza la tabella del picco per il primo spettro 
selezionato

• MS Spectrum Peak List 2 - visualizza la tabella del picco per il secondo 
spettro selezionato

• MS Actuals - visualizza le informazioni sull'acquisizione per lo spettro 
evidenziato

• Compound List - visualizza i composti individuati medianti uno degli 
algoritmi Find Compounds

• Compound Identification Results - visualizza le informazioni di 
identificazione per il composto selezionato

• Spectrum Identification Results - visualizza le informazioni di 
identificazione per gli spettri selezionati

• MS/MS Formula Details - visualizza una tabella con le formule possibili 
calcolate per i frammenti trovati in uno spettro MS/MS
88 Software Agilent MassHunter Workstation - Guida conoscitiva di Qualitative Analysis per LC/MS



4
Utilizzo delle finestre
• Structure Viewer - visualizza la struttura associata al composto o allo 
spettro corrente

• Sample Information - visualizza le informazioni sul file di dati evidenziato

• Sequence Editor - consente di modificare la sequenza di un metodo

È inoltre possibile utilizzare tre finestre degli strumenti visualizzate quando si 
utilizza il relativo strumento:

• Formula Calculator

• Mass Calculator

• Recalibrate
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Utilizzo delle finestre
Icone delle finestre nella barra degli strumenti principali

Le finestre vengono aperte e chiuse utilizzando queste icone della barra degli 
strumenti principale. Sono disponibili altre icone se è installato il software 
MassHunter BioConfirm. Per aprire queste finestre è possibile utilizzare anche i 
comandi del menu View.

MS Spectrum
Results

Data Navigator

Spectrum 
Preview

Chromatogram Results

Method Editor

Method Explorer

Integration Peak List

Spectrum 
Identification 
Results

MS Spectrum 
Peak List 1

Compound List

MS Spectrum 
Peak List 2

MS Actuals

Compound 
Identification 
Results

Sequence 
Editor

Deconvolution
Results

UV Spectrum 
Results

MS/MS 
Formula 
Details

Difference 
Results

Structure 
Viewer

Sample 
Information

Deconvolution
Mirror Plot
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Utilizzo dei risultati di Data Navigator
Utilizzo dei risultati di Data Navigator

Finestra Data Navigator e strumenti

La finestra Data Navigator organizza tutti i risultati dell'estrazione e della 
selezione dello spettro per file di dati o per tipo di dati.

 

Se la funzione è attiva (opzione predefinita), 
quando si evidenzia un cromatogramma in Data 
Navigator vengono contrassegnati anche i relativi 
spettri. Vengono evidenziati anche i risultati 
corrispondenti al cromatogramma e all'immagine 
dello spettro. Linked Navigation funziona soltanto 
se è stata selezionata la voce Integrate and 
Extract Peak Spectra dal menu Chromatograms o 
se è stato utilizzato uno degli algoritmi di 
Compounds.

Single check mark – Contrassegna le caselle di 
tutti i dati evidenziati.

Dual check marks, one gray – Contrassegna le 
caselle dei dati evidenziati e deseleziona le altre 
caselle

Dual check marks – Contrassegna tutte le caselle 
di controllo.

I cromatogrammi e gli spettri vengono visualizzati 
se le relative caselle di controllo sono selezionate.

Strumenti di segno di 
spunta

Icona Linked Navigation
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Operazioni sul cromatogramma

Utilizzando le voci di menu, è possibile eseguire le seguenti operazioni sull'intero 
cromatogramma o su una regione di questo:

Azione Voce menu

Modificare le etichette del picco nel 
cromatogramma

Configuration > Chromatogram Display Options

Estrarre un cromatogramma Chromatograms > Extract Chromatograms

Estrarre i cromatogrammi definiti Chromatograms > Extract Defined Chromatograms

Integrare il cromatogramma Chromatograms > Integrate Chromatogram

Integrare ed estrarre gli spettri del picco Chromatograms > Integrate and Extract Peak Spectra

Integrare e deconvolvere gli spettri del 
picco

Chromatograms > Integrate and Deconvolute Peak 
Spectra

Spianare il cromatogramma Chromatograms > Smooth Chromatogram

Sottrarre un cromatogramma Chromatograms > Subtract Any Chromatogram

Calcolare il segnale/rumore Chromatograms > Calculate Signal-to-Noise

Trovare i composti da dati MS/MS 
automatici

Find > Find Compounds by Auto MS/MS

Trovare i composti da dati MS/MS specifici Find > Find Compounds by Targeted MS/MS

Trovare i composti per dati MS(1) Find > Find Compounds by Molecular Feature

Trovare i composti per dati GC/MS Find > Find Compounds by Chromatogram 
Deconvolution

Trovare i composti per dati MRM Find > Find Compounds by MRM

Trovare i composti sulla base dei risultati 
dell'integrazione

Find > Find Compounds by Integration

Trovare i composti adatti alle formule 
specifiche

Find > Find Compounds by Formula
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Selezionare le operazioni sull'intervallo dal menu di scelta rapida

Dopo aver selezionato un intervallo cromatografico, è anche possibile estrarre uno 
spettro ed estrarre uno spettro su fondo, oltre alle operazioni indicate sopra.

1 Per accedere a tali operazioni, selezionare lo strumento Range Select ( ) nella 
barra degli strumenti Chromatogram Results. 

2 Selezionare il punto di inizio, trascinare il cursore lungo l'intervallo e rilasciare 
il pulsante del mouse.

3 Fare clic con il tasto destro su un punto qualsiasi del cromatogramma, 
quindi selezionare l'operazione dal menu di scelta rapida.

Salvare i risultati sul file di dati

• Fare clic sull'icona Save ( ), o selezionare File > Save Results.

Quando si esce, il programma chiede se si vuole salvare i risultati sul file di dati 
(a meno che questa funzione sia stata disattivata nella finestra di dialogo 
Message Box Options).

Operazioni su uno spettro MS o MS/MS

Utilizzando le voci di menu, è possibile eseguire le seguenti operazioni su uno 
spettro MS o MS/MS o su una regione di questo:

Azione Voce menu

Visualizzare valore m/z, abbondanza, stato 
di carica e altre informazioni sui picchi di 
uno spettro

View > MS Spectrum Peak List 1

Modificare le etichette dei picchi dello 
spettro

Configuration > MS and MS/MS Spectra Display 
Options

Sottrarre lo spettro di fondo Spectra > Subtract Background Spectrum

Sottrarre un qualsiasi spettro Spectra > Subtract Any Spectrum (e poi selezionare 
un altro spettro)

Aggiungere due spettri 
contemporaneamente

Spectra > Add Any Spectrum (e poi selezionare un 
altro spettro)

Ricercare in un database i valori adatti alle 
masse specifiche di un spettro

Spectra > Search Database for Spectrum Peaks
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Utilizzo dei dati cromatografici visualizzati

Finestra Chromatogram Results

Generare le formule per le masse 
nell'intervallo selezionato di uno spettro 

Spectra > Generate Formulas from Spectrum Peaks 
(se nello spettro MS è selezionato un intervallo)

Deconvolvere mediante l'algoritmo 
Resolved Isotope

Spectra > Deconvolute (Resolved Isotope)

Ricercare in una libreria Identify > Search Library for Spectra o
Spectra > Search Library for Spectra

Azione Voce menu
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Strumenti di Chromatogram Results 

Utilizzo dei dati sugli spettri visualizzati

Finestra MS Spectrum Results 

Strumenti di ingrandimento/
riduzione in sequenza

Strumenti di selezione in 
sequenza Range Select – Se impostato su On, è possibile tracciare 

un intervallo per il cromatogramma ed eseguire specifiche 
azioni.

Peak Select – Se impostato su On, è possibile selezionare 
lo spettro di un picco integrato (apex).

Manual Integration – Se impostato su On, è possibile 
eseguire l'integrazione in modo interattivo.

Walk Chromatogram – Se impostato su On, è possibile 
visualizzare i singoli spettri selezionando ciascun punto 
oppure utilizzando le freccia sinistra e destra della tastiera.

Annotation – Se impostato su On, è possibile aggiungere 
immagini e testi ai cromatogrammi.

Autoscale X-axis e Y-axis

Autoscale X-axis

Autoscale Y-axis

Unzoom

Autoscale Y-axis during Zoom

Linked Y-axis mode

Uno di questi strumenti è 
sempre selezionato.
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Finestra MS Spectrum Results 

Strumenti di ingrandimento/
riduzione in sequenza

Strumenti di selezione 
in sequenza

Range Select – Se impostato su On, è possibile tracciare 
un intervallo per il cromatogramma ed eseguire specifiche 
azioni

Annotation – Se impostato su On, è possibile aggiungere 
immagini e testi ai cromatogrammi

Calipers – Se impostato su On, è possibile aggiungere un 
calibro Delta Mass allo spettro selezionato. Nella finestra 
Deconvolution Results, si possono aggiungere un calibro 
Amino Acid o un calibro Modifications. Consultare il Guida 
in linea per ulteriori informazioni.

Autoscale X-axis e Y-axis

Autoscale X-axis

Autoscale Y-axis

Unzoom

Autoscale Y-axis during Zoom

Linked Y-axis mode

Per deselezionare uno 
strumento, fare clic su 
un'altro strumento o 
un'altra icona.
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Workflow

Con i workflow è possibile personalizzare l'interfaccia utente dell'applicazione. 
Ciascun workflow carica un metodo diverso, con parametri adatti per quel tipo 
di workflow. Inoltre, ciascun workflow carica un layout differente. I layout 
consentono di personalizzare le colonne di tutte le tabelle. Per finire, quattro 
tipi di layout offrono una sezione con un editor speciale del metodo che contiene 
le copie delle sezioni dell'editor del metodo essenziali per quel workflow 
specifico. Grazie al raggruppamento delle funzioni indispensabili per un certo 
workflow risulta più semplice personalizzare il metodo.

Nel programma Qualitative Analysis sono disponibili diversi tipi di workflow. 
Sono:

• General

• BioConfirm - Questi workflow sono disponibili soltanto se è installato il 
software BioConfirm e se sono contrassegnati nella finestra di dialogo User 
Interface Configuration. BioConfirm offre vari workflow possibili, a 
seconda del tipo di analisi da eseguire. BioConfirm è utilizzato con file di 
dati LC/MS.

• Chromatogram Peak Survey

• Formula Confirmation and Sample Purity

• MS Target Compound Screening

• GC/Q-TOF Compound Screening

Se si utilizzano dati GC/MS, è possibile selezionare il workflow General o il 
workflow GC/Q-TOF Compound Screening. Se si utilizzano dati LC/MS, è 
possibile selezionare tutti i workflow ad eccezione di GC-TOF Compound 
Screening.

Metodo specifico

Ciascun workflow carica un metodo predefinito specifico insieme alle relative 
impostazioni del workflow. Ad esempio, se si passa ad uno dei workflow di 
BioConfirm, l'opzione per Target data type dell'algoritmo Find Compounds by 
Molecular Feature viene impostata su Large molecules (proteins, oligos). 
Questo valore è adatto al workflow BioConfirm ma, per impostazione 
predefinita, non è accettato dagli altri workflow.
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Layout specifico

Ciascun workflow carica inoltre un layout specifico. Un layout definisce:

• La posizione e la dimensione delle finestre

• Le finestre che contengono schede

• Le finestre mobili

• Le finestre con schede in alto

• Le finestre visibili per impostazioni predefinita

• Se la barra di stato è visualizzata

Per ciascuna finestra con tracciato (finestra Chromatogram Results, finestra 
Spectrum Preview, finestra MS Spectrum Results, finestra Deconvolution e 
finestra UV Results), il programma salva le seguenti impostazioni:

• Se le immagini vengono sovrapposte o meno

• Se lo strumento Autoscale Y-Axis è attivo o meno durante la modalità Zoom

• Se la modalità Linked Y-Axis è attiva o meno

Per ciascuna tabella, vengono salvate le seguenti impostazioni

• Le colonne visibili

• La sequenza delle colonne

• La larghezza di ciascuna colonna

• I filtri aggiunti alla tabella (solo per la tabella Compound List, la tabella 
Compound Identification Results e la finestra Spectrum Identification 
Results).

Sezione specifica in Method Explorer e Method Editor

Utilizzando Method Editor insieme al workflow General è possibile modificare 
quasi tutti i parametri contenuti in Method. 

Gli altri quattro workflow modificano le sezioni disponibili in Method 
Explorer. Le nuove sezioni contengono solo le schede Method Editor e le 
sezioni specifiche per quel workflow. Se si modifica un parametro nella 
sezione del workflow, quel parametro viene modificato anche nella sezione 
corrispondente delle sezioni generali di Method Editor.
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Due schede non vengono ripetute nelle sezioni generali di Method Editor. 
La sezione Chromatogram Peak Survey Workflow > Spectrum Peak 
Identification e la scheda Chromatogram Peak Survey Workflow > 
Chromatogram Extraction > Chromatograms sono incluse soltanto nel 
workflow Chromatogram Peak Survey. Queste sezioni influiscono solo 
sull'algoritmo Chromatogram Peak Survey. Questo algoritmo è utilizzato solo 
in questo workflow, nell'azione Chromatogram Peak Survey without Report 
e nell'azione Chromatogram Peak Survey with Analysis Report.

Metodi e layout dei workflow

Per ciascun workflow sono disponibili altri metodi e layout predefiniti. 

Workflow Metodo Layout Sezione Method Editor 

General default.m Default.xml Nessuno

BioConfirm Intact 
Protein

BioConfirm
IntactProtein-
Default.m

BioConfirm-
IntactProtein-
MaximumEntropy-
Default.xml

BioConfirm Workflow

BioConfirm High 
Mass Intact Protein

BioConfirm
IntactProtein
HighMass
Default.m

BioConfirm
IntactProtein
LMFE.xml

BioConfirm Workflow

BioConfirm Small 
Oligonucleotides

BioConfirmOligo
nucleotideSmall.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Large 
Oligonucleotides

BioConfirmOligo
nucleotideLarge-
Default.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Protein 
Digest

BioConfirmProtein
Digest-Default.m

BioConfirm
ProteinDigest.xml

BioConfirm Workflow

BioConfirm 
Synthetic Peptide

BioConfirmSynthetic
Peptide-Default.m

BioConfirm
SyntheticPeptide.xml

BioConfirm Workflow

Chromatogram Peak 
Survey

ChromPeakSurvey-
Default.m

Default.xml Chromatogram Peak 
Survey Workflow

Formula 
Confirmation and 
Sample Purity

SamplePurity-
Default.m

SamplePurity-
Default.xml

Formula Confirmation and 
Sample Purity Workflow
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Personalizzazione del modello di un rapporto

Consultare la Guida in linea di MassHunter Report Designer Add-in, il 
manuale Report Designer Familiarization Guide o il DVD formativo di 
Reporting per ulteriori informazioni sulla modifica del modello di un 
rapporto. I passi seguenti illustrano rapidamente la procedura di 
personalizzazione di un modello.

1 Selezionare la cartella che contiene i modelli del rapporto. Per impostazione 
predefinita, la cartella è \MassHunter\Report Templates\Qual\B.05.00\en-US\
Letter. È possibile selezionare una cartella diversa in Method Explorer nella 
scheda General > Common Reporting Options > Templates.

2 Fare una copia del modello da modificare. Selezionare con il tasto la copia e 
fare clic su Properties. Se necessario, deselezionare la casella di controllo 
Read-only. Quindi, fare clic con il tasto destro sulla copia e selezionare Open 
dal menu di scelta rapida.

MS Target 
Compound 
Screening

Screening-Default.m Screening-Default.xml MS Target Compound 
Screening Workflow

GC Q-TOF 
Compound 
Screening

GC_Q-TOF.m QTOFData.xml GC/Q-TOF Compound 
Screening

Workflow Metodo Layout Sezione Method Editor 
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Se si apre il modello in questo modo, Excel riconosce che si tratta di un file 
modello. Dopo aver aperto il modello, è possibile modificare le intestazioni e i 
piè di pagina, aggiungere, rimuovere o spostare le colonne dei parametri. 
Consultare la Guida in linea per ulteriori informazioni. Tutti i modelli di 
Qualitative Analysis sono contrassegnati come modelli in sola lettura. 
È possibile modificare questa proprietà prima di elaborare un modello.

Insieme al programma Qualitative Analysis vengono installati molti 
modelli. Consultare la Guida in linea di Qualitative Analysis per ulteriori 
informazioni sul contenuto di ciascun modello del rapporto.
Software Agilent MassHunter Workstation - Guida conoscitiva di Qualitative Analysis per LC/MS 101



4
Personalizzazione del modello di un rapporto
3 Apportare le modifiche.

Per ulteriori informazioni sulla modifica di un modello, consultare la Guida 
in linea di MassHunter Report Designer add-in, o il DVD formativo di 
Agilent MassHunter Reporting.

4 Per salvare un nuovo modello, selezionare Save o fare clic su Save As > Other 
Formats dal pulsante Microsoft Office. 

5 Digitare un nome identificativo, e selezionare Save.
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